HP Service Manager
for supported Windows® and UNIX® operating systems

Release Notes
Software version: 9.31.0022/ October 2012 (Updated June 18, 2013)
This document provides an overview of the changes made to HP Service Manager for the 9.31.0022 release.
It contains important information not included in the manuals or online help.

Patch Release Strategy Change for Service Manager 9.3x
Over the last few years we have consistently received feedback from our customers that, while Service
Manager is a great feature-rich product, a number of quality issues remain. We are pleased to announce that
we have released just as many Service Manager patches over the last year as in the past, but with the
following significant differences:
•

After only three quarters of 2012, we have already fixed 50% more defects in those patches than in the
entire of the last year.

•

Over 60% of these fixed defects were on Service Manager 9.3x. We have dramatically enhanced our
testing procedures for SM 9.30 to find more defects than ever before. This has enabled us to proactively
fix these defects before customers can report them.

•

We are not only fixing platform defects, but also releasing improvements to the applications, the
documentation and the upgrade process.

Initial customer feedback indicates that our new strategy is working. However, we know that fixing defects
is not enough to keep Service Manager ahead of our competitors. Our customers also want us to make
smaller enhancements to the product to improve usability and supportability at a far more rapid pace. To
that end, we are changing the patch release model for Service Manager 9.3x:
•

We plan on creating a 9.3x minor-minor patch release (for example, SM 9.31, 9.32, and so on) every 6 to
9 months. These minor-minor releases will contain enhancements to functionality and new features.

•

Once a new minor-minor patch is released, the build patches (for example, 9.30p5) on the previous
release will stop. After the SM9.31 release, there will be no further patches on SM9.30.

•

We will continue to release build patches (for example, 9.31p1) on a regular basis between minor-minor
patch releases.

•

Minor-minor patches can be adopted component by component. For example, if you only need the
platform updates, you do not need to do an applications upgrade. When the release is posted on HP
Software Support Online (SSO) portal, the components will be structured so that you can download only
the parts you require. The release notes will clearly indicate any dependencies if they exist.

There is no change in release strategy for older versions of Service Manager, such as SM9.21 and 7.11.
We hope this release strategy will meet your needs for a continued high-quality Service Manager on-premise
product.
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Documentation Updates
The first page of this release notes document contains the following identifying information:
•

Version number, which indicates the software version.

•

Publish date, which changes each time the document is updated.

To check for recent updates or to verify that you are using the most recent edition, visit the following URL:
http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.
You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HP sales representative for details.
Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To
download Adobe Acrobat Reader, go to the following web site:
http://www.adobe.com/
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In This Version
Note: Service Manager (SM) 9.31 includes all the features of SM 9.30.p5, SM9.30ap3, SM9.30up6, and
previous releases. If you are upgrading from a version earlier than SM 9.30.p5, 9.30ap3, or 9.30up6, review
the release notes for the following releases since SM9.30:
•

SM9.30p1 through p5

•

SM9.30ap1 through ap3

•

SM9.30up1 through up6

Support of HP Service Request Catalog 1.40
Prerequisites:
Service Request Catalog 1.40 requires either of the following:
•

The Service Manager 9.31 applications (if Knowledge Management is not enabled).

•

The Service Manager 9.31 applications + 9.31 Solr Search Engine (if Knowledge Management is
enabled).

Service Request Catalog is a front-end application that gathers data from Service Manager and organizes
available products and services into a catalog format. Service Request Catalog 1.40 includes new features or
enhancements in the following areas.

Service Request Catalog End User Enhancements
Service Request Catalog 1.4 includes a number of new features to expand the functionality of SRC and to
provide a smooth and user friendly experience to end-users. For more information on how to use SRC from
an end-user’s perspective, consult the built in help server after installing SRC.
Global Catalog Search
This version of SRC enables extended search capabilities from the Service Catalog items, Support Catalog
items, and Knowledge Management documents from Service Manager 9.31. Users can use search to quickly
find items in the catalogs, knowledge bases, and also content from an outside URL. In addition, a shortcut
has been added to allow users to a quick launch to request custom support options if they cannot find an
applicable support item from the catalog. These search features greatly streamline service and support by
enabling end users to resolve their issues independently.
Service Subscriptions
SRC now allows users to quickly view and manage their subscribed services through the introduction of a
new Subscription page and Dashboard widget. Users can obtain a history of their subscribed items, or delete
a subscription which they no longer need.
Approvals
SRC now supports Approvals and Approval delegation. Upon logging into SRC, users will see a new
Approvals widget that displays the number of approvals in their queue. Users can view their current
approvals and quickly approve or deny requests. In addition, users can designate an appropriate back-up
Approver through the Settings window.
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Service Request Catalog Administration Enhancements
Service Request Catalog 1.4 adds a number of new features that allow administrators to customize SRC to
their organization’s needs. The features include the creation of custom fields, more flexibility in
customization, and new “Launcher” from which users can link to other Web sites or launch 3rd party support
applications. For information on these features and how to customize SRC, see the “Service Request Catalog
Customization Guide.”
Support for Creating Custom Fields
Service Request Catalog 1.4 adds support for custom field in the panel of a request. These fields enable
organizations to gather additional data beyond the standard SRC format. Such data might include
customer specific information, such as location information, fax numbers, or similar. Custom fields are
added from the Service Manager side.
Customization of the SRC
This version of SRC allows for greater control of the look and feel of the catalog. In this version, you can
customize the visibility and arrangement of the widgets, brand the SRC by adding your organizations logo
and modify the color scheme.
Built-in Applications Launcher
SRC also adds an area, called the Launcher, which allows you to add links to launch third party
applications. Examples of third party links might include such things as a video for training, the launching
of a chat support application, or link to a search Web site.

RecordList Improvements (Web Client only)
Prerequisite: This new feature requires the Service Manager 9.31 Web tier.
The RecordList functionality has been improved to achieve better performance and usability in the Web
client. The performance has been significantly improved when users are working with record lists, and
improvements have been made in the following areas: grouping, page navigation, drilldown, and
keyboard/mouse operations. These improvements include:
•

On a list-only page (for example, a To-Do queue), the first visible column in each row is a drill-down link.
Clicking this link opens the record.

•

On a list-only page, a single click on a row no longer opens the record, and it selects the row instead.

•

The focused row now has a black border and an orange or gray background (when selected or not
selected), while selected rows have an orange background but without a border. This distinction is
helpful when users perform keyboard operations, which take effect only on the focused row.

•

More keyboard shortcuts are supported.

•

New grouping behavior when a list-only page is reloaded (for example, when users refresh or resort the
record list): if viewrecordlist is set to true, the group that contains the current row (that is, the last
selected row) is expanded; if viewrecordlist is set to false, the first group in the list is expanded (the first
row becomes the current row).

•

The controls on the paging bar now enable more efficient and convenient page navigation for record lists.

For details, see the RecordList improvements (Web client) and Working with record lists topics in the Service
Manager help.
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HP Service Manager Collaboration (SM Collaboration)
Prerequisites: SM Collaboration requires the following:
•

Service Manager 9.31 Web tier

•

Service Manager 9.31 applications

•

HP Enterprise Collaboration (EC) 1.1

By integrating with HP Enterprise Collaboration (EC), HP Service Manager Collaboration (SM
Collaboration) enables SM and non-SM users to collaborate in real time (or anytime) in the context of an
Incident, Service Desk Interaction, Change, or Change Task. Non-SM users can participate in the
conversation using the EC stand-alone web interface or using Microsoft Office Communicator/Lync. SM
Collaboration suggests participants to be invited to the conversation based on the context of a record, such as
contact, configuration item (CI), service, or assignment group. You can also search users by email address or
user name, and invite them to the conversation. The conversation is stored as a permanent part of the
corresponding record.
For more information, see the Integrations section in the Service Manager 9.31 online help.

SM-BSM Downtime Synchronization
Prerequisites: This new feature requires the Service Manager 9.31 applications and
ServiceManagerAdapter9-x/UCMDB9.05 CP11 Update 2.
The integration between Service Manager (SM) and BSM now supports synchronization of scheduled
downtimes from SM RFCs and tasks to BSM in order to suppress events. For more information, see the
Integrations section in the Service Manager 9.31 help.

UCMDB Integration Enhancement
Prerequisites: This enhancement requires the following:
•

Service Manager 9.31 applications

•

Service Manager 9.31 server

•

ServiceManagerAdapter9-x/UCMDB 9.05 or 10.0

The UCMDB integration has been enhanced in the following areas. For more information, see the Service
Manager 9.31 Universal CMDB Integration Guide, which is available from the online help.

Support of UCMDB 10.0
The SM-UCMDB integration now supports UCMDB 10.0, in addition to UCMDB 9.x.
Note: The new features in this release are not supported for UCMDB versions earlier than 9.05.

Accessing the UCMDB Browser from the Service Manager UI
Prior to Service Manager (SM) 9.31, users can launch the UCMDB UI in the context of a CI record
synchronized from UCMDB. In SM 9.31, users can launch the UCMDB Browser UI instead of the UCMDB
UI, in the context of a CI record.
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The Universal CMDB Browser is a lightweight UI designed for simple access to UCMDB configuration
information. This is a tool for searching, locating and consuming configuration related data. It is an optional
add-on to UCMDB. For more information, refer to the UCMDB Browser documentation.
Limitations
If the UCMDB server supports multi-tenancy, every user is associated to a tenant or tenants. No tenantspecific information is provided in the UCMDB Browser URL.
If the UCMDB server supports multi-customer, customer information is not provided in the UCMDB
Browser URL. By default, users are logged in to the system of Customer 1.

Populating UCMDB with CI/CI Relationship Data from Service Manager
This feature is helpful for synchronizing several types of CIs that cannot be automatically discovered in
UCMDB and CIs that are created and managed in Service Manager.

Improved Error Handling for UCMDB to SM Synchronization
The integration’s error handling mechanism has been improved to ensure that a single CI failure does not
cause a complete push to fail; instead the push job completes with a “Passed with failures” status. Full and
differential pushes now run to completion without constant monitoring.

Performance Tuning for UCMDB to SM Synchronization
This enhancement enables the Service Manager Adapter to connect to multiple Service Manager Instances
for parallel processing of data push.

Additional DEM Rule Options for Duplicated Logical Name Values
This feature enables push of CIs with a duplicated logical name in SM. You can configure DEM Rules on
their Duplication Rule tab to either rename duplicated logical names or return an error:
•

Rename to <name>_RENAMED_1/2/3

•

Return Error

Note: The error message will contain this string: “This record contains an invalid duplicate key.”

Automatically Loading Managed Fields in DEM Rules
A new button named Load Fields is now available on the Managed Fields tab of DEM Rules. This button
enables you to load managed fields automatically.

Support for Enabling Outage Spreading
This feature enables all CI relationships pushed from UCMDB to SM to be involved in the outage
dependency functionality. When a CI relationship is pushed from UCMDB to SM, the "Outage Dependency”
is set to true, and the outage threshold is set to "1".
In a DEM rule record, if the Table Name is "cirelationship", a new option Add the record, and set
dependency as true is available for Action if matching record does not exist.
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New Options for Synchronizing CI Deletions from UCMDB to SM
In a DEM rule record, if the Table Name is not "cirelationship", new options are now available for Action if
record is to be deleted.

Enriched CI and CI Relationship Mapping for UCMDB to SM Synchronization
The out-of-the-box integration content has been enriched to support more CI/CI Relationship types and
subtypes for data push.

Mobility Client Enhancements
Prerequisites:
The Mobility enhancements require either of the following:
•

The Service Manager 9.31 Mobility client + 9.31 applications

•

The Service Manager 9.31 Mobility client + 9.30 or later applications + two unloads
(QCCR1E76227_SM930P6_SM930.unl and QCCR1E78794_SM930P6_SM930.unl, available from the
SM9.31 server’s platform_unloads directory).

This release includes the following enhancements to the Service Manager Mobile Applications version 1.0:
•

Localization support. The Mobile Applications now supports four additional languages: French, German,
Japanese, and Spanish.
Note: To support localization of messages returned from the Service Manager RTE, the 9.31 RTE is a
prerequisite.

•

Support of custom date formats for date/time fields in Change Management views.

•

Ability to reassign Incident and Change records.

For more information, see the Service Manager 9.31 Mobile Applications User Guide, which is available from
the Service Manager 9.31 online help.

Lock Management
Prerequisite: This new feature requires the Service Manager 9.31 server.
In versions of Service Manager (SM) prior to version 9.31, the locking mechanism used multicasting to
request and obtain a lock on a resource in Service Manager. This locking mechanism was implemented using
a Peer Lock in the JGroups toolkit. However, there were several issues with this implementation, which are
addressed with the new locking mechanism introduced in this release.
The new locking mechanism consists of a record entry for each locked resource in a database table. The new
lock table (for exclusive locks) and lockshared table (for shared locks) have been created to house these
records.
Limitations/Known Issues:
•

No lock queue

•

Resource Name is limited to 200 bytes.
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For detailed information on the new locking system, see the Lock Management topic in the Service Manager
9.31 online help.

Dynamic Debugging of User Sessions or Schedulers
Prerequisites: This new feature requires the Service Manager 9.31 server and 9.31 applications.
Note: This feature does not work in non-English environments because of localization limitation
QCCR1E62656.
Prior to version 9.31, Service Manager (SM) provides the ability to enable debugging information by
restarting or re-connecting the SM Server to reload the modified sm.ini file, which contains the settings of
debugging parameters. However, in some cases, support personnel need the ability to turn on the SM
debugging dynamically without disconnecting/stopping a user session/scheduler. For example, a
session/scheduler is having a performance problem after a continuous running for a long time, and no
debugging was enabled and history indicated that once the session/scheduler was disconnected/stopped and
then re-connected/restarted the performance issue went away.
Service Manager 9.31 introduced the dynamic debugging feature, which enables administrators to enable or
disable debugging or tracing information for a user/scheduler session, without the need to restart the server.
When enabled, relevant debugging information of that session/scheduler will be written to the server log
(sm.log). Once you have finished troubleshooting, you can then disable some debugging information for that
user session or scheduler, using dynamic debugging; however some debugging information cannot be
disabled using dynamic debugging, and in this case the user needs to reconnect to the server or an
administrator needs to manually stop and then restart the scheduler, to disable such debugging information.
Important: If multiple sessions exist for one user account or scheduler (for example, one user logs in
simultaneously from different clients or multiple instances of one scheduler have been started), the dynamic
debugging settings specified for one of these sessions will take effect for all of the sessions of this user
account or scheduler.

Set debugging parameters using dynamic debugging
Note: Some debugging parameters can be enabled and disabled using the dynamic debugging feature, while
some can be enabled but cannot be disabled using this feature. For more information about these
parameters, see Dynamic debugging supported parameters.
To set debugging parameters for a user session/scheduler:
1

Click System Status.

2

Type “s” in the Command box of the user session/scheduler, and click Execute Commands. The
Operator Status Display form opens.
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3

Click the Send Debug Msg button in the toolbar. The Send Debug Message form opens.

4

Set debugging parameters as needed. For supported parameters, see Dynamic debugging supported
parameters.
The following figure shows an example.

5

Click the Send Debug Message button. A message displays: Message sent to all users specified.

6

Click End to exit.

7

Check the server log file for relevant debugging information of the session/scheduler.

8

Once you have completed troubleshooting of the session/scheduler, you may want to disable the
debugging parameters for the user session/scheduler. To do so, repeat the steps above and disable the
parameters.
Note: Some parameters cannot be disabled using dynamic debugging. To disable such debugging
information, disconnect the user session or manually restart the scheduler. See Dynamic debugging
supported parameters.

Dynamic debugging supported parameters
The following debugging parameters can be enabled and disabled in dynamic debugging.
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Parameters that can be enabled and disabled using dynamic debugging
dbmonitorfiles: [file1],[file2]…

debugscauto

ir_trace

debugca:n

debugvmmap

rtm

debughttp

debuglk

sqldebug

debugdiagnostics

debugrs

The following parameters can be enabled but cannot be disabled using dynamic debugging.
Note: Once you have completed debugging of a user session or scheduler with any of these parameters
enabled, you are recommended to re-connect the session or restart the scheduler to disable the parameters.
Parameters that can be enabled but cannot
be disabled using dynamic debugging

Performance Impact

dbtriggertrace

Low

dbstats

Low

debugattachments

Low

debugjni

Medium (only affects the target session/scheduler)

debugjavascript

Medium (only affects JavaScript execution of the
target session/scheduler)

debugadhocsql

Medium (only affects the target session/scheduler)

debugfileio

Low

debugshutdown

None

debugprocesses

Medium (only affects the target session/scheduler)

debugdbtypes

Low

debugdbquery

Low (Setting debugdbquery:0 can disable 99% of the
relevant logs)

See also the Dynamic debugging of user sessions/schedulers and Set debugging parameters using dynamic
debugging topics in the Service Manager 9.31 online help.

Planning CI Relationship Changes from a Change Record
Prerequisites: This new feature requires the Service Manager 9.31 applications and 9.31 server.
In Service Manager earlier than version 9.31, you can plan Configuration Item (CI) attribute changes from a
change record, but you can only change relationships immediately rather than plan them for future changes.
On the other hand, it is possible to have CI relationships be validated through UCMDB (which may result in
unplanned changes), but it is impossible to plan CI relationship changes.
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Service Manager 9.31 now provides the ability to plan CI relationship changes from a Change record of the
Planned Change category. Two tables (dataModEventRel and dataModEventRelItem) were added to store
the data modification events of relationship records and their downstream CIs. In addition, the same data
modification event status change applies for both CI attributes and CI relationships. All changes will be
logged incrementally. For example, if a change plans to add one downstream CI to an existing relationship
that already has two downstream CIs, only the new downstream CI will be listed for tracking or approval.
The following describes two typical use cases of this enhancement.

Add a CI relationship to be changed in a planned change record
Use the Add Attributes/Relationships button or the More > Set Expected States option to add CI
relationships to an existing change record of the Planned Change category.
1

From Change Management, open a change record that is not approved.

2

Click More > Set Expected States. Alternatively, open the Associated CIs section, and click the Add
Attributes/Relationships button.

3

Select one CI you want to modify, and click Next.
Note: If the change record has only one affected CI, this step is automatically skipped; if the change
record has no affected CIs, the Set Relationship option will not be selectable in the next step.
Warning: You can select only one CI in this step; otherwise the Set Relationship option will not be
selectable in the next step. This is because you can add relationships for only one CI at one time.

4

Select Set Relationship, and click Next.
A new form opens. If the selected CI has existing relationships, two options display: Add New
Relationship and Update/Delete Existing Relationship; if the selected CI has no existing
relationships, only the first option displays.

5

Select Add New Relationship, and click Next. The Relationship Definition form opens.

6

Complete necessary fields on the Relationship Detail and Outage Dependency tabs, and click
Finish. See the following figures for examples.
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A message similar to the following displays: Change Event for relationship
"desk104connection101" linked to Change "C10002".
7

Go to the Associated CIs section of the change record, and locate the new relationship in the “CMDB
relationships need to be changed for CIs in the list” table. The new relationship has a Status of Proposed.

8

Click the link of the new relationship to view the relationship details.

9

I f needed, change the Status from Proposed to Cancelled, and save your change. If cancelled, the
relationship changes will not be processed.
Note: When the change record has been approved and moved to the implementation phase, the status of
the new relationship (if not cancelled) changes from Proposed to Planned, and the relationship changes
will then go through the rest of the change workflow.
Next, you can view the new CI relationship from the affected CIs. In this example, the affected CIs are
“adv-afr-desk-104” and “adv-afr-desk-101”.

View the CI relationship from the affected CIs
Once you have added a new relationship for an affected CI of a change record, you can find the relationship
in the Relationship Changes sections of the upstream and downstream CI records, with a link to the
change record.
See the following figure for an example.

See also the Plan CI relationship changes from a change record topic in the Service Manager 9.31 help.

Enhanced Web Client Session Management to Prevent Data Loss
Prerequisite: This new feature requires the Service Manager 9.31 Web tier.
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Prior to version 9.31, if a user has already logged in to the Service Manager Web client and then opens a new
Web client in the same session, the session may collide and unexpected behaviors will occur. For example, if
a user logs into the web client in POWER mode, and then opens another page in ESS mode, the newly
opened page will cause the original working page to automatically log out. This may result in front tier data
loss depending on the application modes of the two pages (see defect QCCR1E73015).
As of version 9.31, Service Manager (SM) allows only one live web client in the same web browser session to
avoid potential data loss. The following describes two typical example scenarios.

Typical Scenarios
The following describes the current web client behavior in two typical scenarios. In these scenarios you
attempt to open the web client in two browser tabs in the same session.
Scenario 1. Access the web client in different modes in two browser tabs.
In this scenario, you log in to the web client in one mode (index.do for example) and try to access the web
client in another mode (ess.do for example) in another browser tab. In the following example, you log in to
the web client in the index.do mode, and then you attempt to open an Incident record link in the ess.do mode
from an HTML email notification.
1

Log in to the web client (index.do) in your default web browser, and open one or more SM tab pages (for
example, a Service Catalog page).

2

Click the link in your email notification.
The link opens in another tab in your default browser (if your browser is configured such that it opens
external links in a new tab).

3

The following warning screen displays. The two options allow you to select in which mode you want to
open the web client in the new browser tab. By default, the mode used in the first browser tab (which
requires no re-login) is selected. Note: The options vary with the web client modes used in the two
browser pages.

4

Save your work in the original browser tab.
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5

In the new browser tab page, select one mode, and click Continue or press Enter.
— If you select Open the Service Manager ESS application, a login page opens. After you log
in, the web client opens in the new mode. Note: If you are using Trusted Sign-On (TSO), a “Login in
progress” page will display instead and no login is required.
— If you select Open the Service Manager main application, the web client directly opens in
the original mode with the original SM tab pages recovered and the linked record displayed.

6

Return to the original browser tab. The following message displays: The page has expired. Please
close it. Close this browser tab, and continue your work in the new one.

Scenario 2: Open the web client in the same mode in two browser tabs.
In this scenario, you open the Service Manager web client in the same mode (for example, index.do) in two
browser tabs in the same session. Note: The following example uses the Power (index.do) mode. In the ess
mode, you can open only one tab page, and therefore the original tab page may not be recovered in the new
browser tab if a different tab page is open.
1

Log in to the Service Manager web client (index.do), open multiple SM tab pages and update one or more
of the pages (for example, update a Service Catalog item) without saving.

2

Launch the web client (index.do too) in another browser tab in the same browser session. The following
warning occurs:

16

3

Save your changes in the original browser tab.

4

Go back to the new browser tab page, and click Continue or press Enter. The web client opens in the
new tab page, with the original SM tab pages recovered.

5

Go back to the original browser tab. The following message displays: The page has expired. Please
close it. Close this browser tab, and continue your work in the new one.

Known Issues
This enhancement has the following known issues.
Issue 1: Process Designer workflow tab pages (Tailoring > Process Designer > Workflows) that are open
in the original browser tab cannot not be recovered in the new browser tab.
Issue 2: When refreshing the Service Manager web client in the new browser tab using the browser’s
Refresh feature, you may see a browser warning. Ignore the warning, and click Retry (in Internet Explorer)
or Resend (in Firefox) to continue.

Issue 3: A warning page displays when downloading files from the browser. See QCCR1E78426.
Issue 4: In a TSO environment, opening multiple links to the SM Web tier rapidly may cause unexpected
errors or session timeouts.
Service Manager creates a temporary session during login. If a user opens multiple links too fast, the
following may occur:
•

The subsequent requests may be sent before the first request gets returned with a temporary session.
The server therefore does not know if these requests are from the same browser session.

•

The temporary session may be terminated at the server side after a successful login, and therefore all
requests with the temporary session may result in a logout. This logout will direct the web client to a
goodbye page, which will terminate the user’s session at the server side.
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•

If the user has logged on to the web client, all subsequent requests will open up a warning page; only the
most recent page is kept active, and the others are expired.

Accessibility Improvements
This release includes the following accessibility improvements for the accessible Web client.
Prerequisites: The accessibility features require the Service Manager 9.31 Web tier.

Ability to Use HTML Headline Tags in the Label, Wrap Label, and Group Widgets
Prior to version 9.31, the Web client does not use appropriate HTML headline tags (h1, h2, etc.) for HTML
headers. This is problematic for screen readers used for accessibility.
To solve this issue, the following features have been introduced, which take effect only in the accessible
mode (accessible.do and accessible-ess.do):
•

In Forms Designer, a new property Heading Level is available for three types of controls: Label, Wrap
Label, and Group. Its valid values are: 1 through 6 (1 represents h1, and so on). The Heading Level
property has no default value. Once a valid value is specified, when rendered to HTML, the text for these
widgets will be enclosed in the corresponding paired headline tags.

•

The tab title of the current active tab is enclosed in the <h1> tag.

Accessing the System Navigator Using Keyboard Shortcuts
Prior to Service Manager 9.31, the Tab key can move the focus around all fields on the screen, but the focus
never reaches the System Navigator. There are no other keyboard shortcuts that can be used to access the
navigator area. See QCCR1E59306.
As of Service Manager 9.31, users can use keyboard shortcuts to access the System Navigator. All elements
in the navigator tree (buttons, tree panel, and tree nodes) are reachable by using Tab or Shift + Tab key
commands in a default browser sequence.
Note: This enhancement works for all Web client modes: index.do, ess.do, accessible.do, and
accessible_ess.do.
Limitations
•

When JAWS is running, only Internet Explorer is supported.

•

The keyboard shortcuts are not functioning when the focus is moved to the MySM content pane.

•

If you navigate to pages opened from Manage Favorites, you cannot return to the system navigator
using ALT + Q.

New Keyboard Shortcuts
The following table describes the supported shortcut keys.
Shortcut Key(s)

Description

Space

Expands or collapses the tree panel.
Expands or collapses tree nodes that have children. Note: If JAWS
is running with Virtual PC Cursor enabled (default), use "Ctrl +
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Shortcut Key(s)

Description
Space" instead.

Left/Right Arrow

The Left and Right keys expand or collapse tree nodes that have
children.
Note: If JAWS is running, this is not supported.

Ctrl + Alt + N

Moves the focus to the first toolbar button in the navigator.

Ctrl + Alt + M

Moves the focus to the first toolbar button in the main content pane.

Ctrl + Alt + L

If the current page is a list/detail page, moves the focus to the first
toolbar button in the list pane.

Ctrl + Alt + D

If the current page is a list/detail page, moves the focus to the first
toolbar button in the detail pane.

Alt + Q

Navigates through the following panes (not including the toolbar
buttons) on the page:
•

Navigator + main content

•

Navigator + list pane + detail pane (if the active tab page is in
the list/detail view)

Notes:

On triggering the Alt-Q keys, instead of focusing on the first
element of each pane, the focus is remembered. Therefore, the
remembered element is re-focused when the user returns to the
panes. However, if the content of that pane is refreshed, the
navigator will focus the first tree panel. Or, if it is the main content
pane, the focus will target the frame window of that section.
Pressing Tab once will cause the focus to target the first element in
the browser’s default sequence.
See also the Service Manager 9.31 Accessibility Guide, which is available from the Service Manager 9.31
help.

Manual Updates Required for Knowledge Management
Important: These manual updates are required only when you have upgraded your Service Manager server
and clients to version 9.31 and stay with a previous version of the applications. If you have already upgraded
to the 9.31 applications, these updates are no longer required.
Note: If you do not make these updates, an “Unexpected script” line will display on the Search
Knowledgebase page:
Unexpected script: <script> //modify htmlviewer border in firefox var
iframe=parent.document.getElementsByTagName("iframe")[0]; if(iframe!=null) {
iframe.setAttribute("frameborder",0); } </script>

Perform the following steps to prevent the error line from occurring:
1

Log in to the Service Manager Windows client as a system administrator.

2

Update the Knowledge Management environment record.
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a

Navigate to Knowledge Management > Administration > Environment.

b

In the Style text for search results box, remove the following lines:
<script>
//modify htmlviewer border in firefox
var iframe=parent.document.getElementsByTagName("iframe")[0];
if(iframe!=null)
{
iframe.setAttribute("frameborder",0);
}
</script>

c
3

4

Save the environment record.

Update the kmknowledgebase.search.g format.
a

In Forms Designer, open the kmknowledgebase.search.g format in the Design mode.

b

Select the HTML Viewer widget, and set its Frameborder property to 0 (zero). No border will be
displayed for the HTML Viewer.

c

Save the format.

Log off Service Manager and log back in for the changes to take effect.

Upgrade to LW-SSO v2.5 (Server and Web Tier)
As of version 9.30p5, the Service Manager Web tier and server have upgraded to LW-SSO version 2.5.
In the Web tier’s lwssofmconf.xml file, a new parameter, secureHTTPCookie, has been introduced. The
default is "true". This parameter must be set in combination with the secureLogin parameter in the Web tier
configuration file (web.xml) so that LW-SSO can work correctly:
•

If secureHTTPCookie is set to true, secureLogin must also be set to true;

•

If secureHTTPCookie is set to false, secureLogin can be set to true or false as needed (you are
recommended to set both to true in a production environment).

For more information, see the Configure LW-SSO in the Service Manager Web tier and Configure LW-SSO in
the Service Manager server topics in the Service Manager 9.31 help.

New JavaScript Global Methods, JavaScript Functions, and Parameters
The following JavaScript global method was introduced in this release.
JavaScript Global Method

Description

setAppMessage

This function defines the message returned in the "message"
attribute in a SOAP response.
For details, see the Service Manager 9.31 Programming Guide.
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JavaScript Function

Description

getBinary

A JavaScript function that returns the binary representation of a
field.
For details, see the Service Manager 9.31 Programming Guide.

The following new parameters were introduced in this release. For more information, see the System
Configuration Parameters section in the Service Manager 9.31 online help.
Parameter

Description

deadnodelocktimeout

The new locking mechanism implements
the deadnodelocktimeout parameter.
This parameter specifies the amount of
time that must elapse before a process
forcibly removes a lock from the Lock or
LockShared table.

Location
•

Initialization file (sm.ini)

Note: Does not require a restart
of the Service Manager server.

Default: 10 (10 minutes must elapse
before a record is forcibly removed.)
Possible Values: No less than 10
minutes
fetchnotnullsystemp

This parameter specifies whether or not
to fully enable the template merge
functionality for tables that have a
systemplate field (for example, the
operator table). When this parameter is
set to 1 (enabled) in the sm.ini file,
records that have a non-NULL
systemplate field merge the template
record before they are passed to the
query condition filter. As a result,
records whose systemplate field is not
empty will be included in query results.
Default: 0 (Do not fully enable the
template merge functionality).
Possible Values:

•

Server's OS command
prompt

•

Initialization file (sm.ini)

Note: Does not require a restart
of the Service Manager server.

0 (Do not fully enable the template
merge functionality).
1 (Fully enable the template merge
functionality).
grouptimeout

This parameter allows you to configure
the timeout value (in milliseconds) for
Jgroups remote procedure calls. You can
tune this value to keep the number of
available nodes stable.
It is recommended to set this parameter
to a minimal value as long as it can keep
the number of the available nodes
stable. Meanwhile, the network latency
between the web server and the HP
Service Manager server should be small,
otherwise the load balancer may forward

•

Server's OS command
prompt

•

Initialization file (sm.ini)

Note: Does not require a restart
of the Service Manager server.
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Parameter

Description

Location

a request to a node that is not able to
handle the request due to network
latency.
Default: 1000 (milliseconds)
Possible Values: Any number of
milliseconds from 300 to 10000
jsaccesscmdregex: <regex>
jsaccessfilewriteregex:<regex>

jsaccessfilereadregex:<regex>

These parameters specify access
restrictions from JavaScript code for file
access and command execution. This is
required for security reasons so that
users with Process Designer tailoring
rights are not able to use the available
Service Manager JavaScript APIs to
directly access the underlying host file
system and command line in an
unauthorized way. These restrictions are
described below:
•

System administrator (sysadmin)
users are allowed unrestricted access
to the file system and command line

•

Non-sysadmin users are allowed
unrestricted access as well by
default (none of these configuration
parameters is present); if any of
these parameters is present, access
is restricted as follows.

•

Server's OS command
prompt

•

Initialization file (sm.ini)

Note: Changing any of these
parameters requires a restart of
the Service Manager server.

jsaccessfilereadregex:<regex>:
A regular expression for the absolute
paths of all files allowed to be read using
the readFile(), and uncompressFile() JS
functions
jsaccessfilewriteregex:<regex>:
A regular expression for the absolute
paths of all files allowed to be written
using the writeFile(), deleteFile(),
makeDir(), uncompressFile() (output
dir), and writeAttachmentToFile() JS
functions.
jsaccesscmdregex:<regex>:
A regular expression for OS commands
(including parameters) allowed to be
executed using the sysExec() JS
function.
Notes:
•

The following strings are not allowed
in the command line run by
sysExec(): "||", "|" , ";" , "``"
(backquotes), "&&", "&", ">>", and
">".
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Parameter

Description
•

If the use of any of these
mechanisms in the command line is
needed, administrators can put the
real command line in a .sh or .bat
file, and run the .sh/.bat file in
sysExec() instead.

•

Audit warning messages will be
logged in sm.log, if SM found that
any JavaScript attempted to access
unauthorized file/paths or run
unauthorized commands, or used
those forbidden strings in the
command line run by sysExec(). The
messages include the file/paths to be
accessed, or the commands to be run,
and the user’s login name.

Location

Default: By default, none of these
parameters is present, which means no
JavaScript access restrictions for file
access or command execution.
maxGroupCacheSize

This parameter defines the maximum
number of groups that can be cached in
the user’s browser when the user
navigates through the groups in a record
list.
Default: 300

•

Web tier configuration file
(web.xml)

Note: Requires a restart of the
Web application server.

Possible Values: No less than 300

recordListArrayDisplayStyle

This parameter defines how array fields
are displayed in record lists (for
example, To-Do queue lists, lists in the
list pane of list/detail pages, and lists
generated by clicking the Fill button),
and it takes no effect on table objects (for
example, tables in the detail pane of a
list/detail page). The parameter can be
set to one of the following values:
•

1 (default): The original content
length of each array column value is
truncated to the value defined in the
recordListArrayMaxChars
parameter.

•

2 (recommended): Array type
columns are not displayed in record
lists. This option is recommended
because displaying array fields in
record lists can have a negative
impact on performance.

•

3: Keep the original content length of
each array column value in record
lists. This is the old behavior when

•

Web tier configuration file
(web.xml)

Note: Requires a restart of the
Web application server.
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Parameter

Description

Location

this parameter was not introduced.
Note: The setting of this parameter has
no effect on the Export to Text File
functionality. When you export a record
list to a text file, array fields are always
exported with their original content.
Default: 1
Possible Values: 1, 2, and 3
recordListArrayMaxChars

This parameter defines the maximum
allowed field length of any array fields
that appear in record lists. It takes effect
only when the
recordListArrayDisplayStyle parameter
is set to "1".
Default: 100 (bytes)

•

Web tier configuration file
(web.xml)

Note: Requires a restart of the
Web application server.

Possible Values: No less than 1

Obsolete Parameters
Server parameter releasesem is obsolete in this release. See QCCR1E79393.

Open Source and Third-Party Redistributables Package
In this release, the web tier package and each of the server packages contain a compressed file,
sm9.31.0022_Redistributables.zip. This zip file contains all open-source and third-party source code
used in this release, as well as associated license agreement files.
Note: The content of this .zip file is an updated version of that in the Redistributables folder on the Service
Manager 9.30 installation media.
For a complete list of open source and third-party acknowledgements, see the Service Manager 9.31 Open
Source and Third-Party Software License Agreements manual (in PDF format).

Documentation Release
The Service Manager and SRC online help, and other documents have been updated for this release. You can
download them from the HP Software Manuals site at: http://h20230.www2.hp.com/selfsolve/manuals

Service Manager Documentation
•

Service Manager 9.30 Interactive Installation Guide
(SM_930_Interactive_Installation_Guide.zip)

•

Applications Patch Manager Guide

•

List of Objects Added or Updated by the 9.31 Applications Patch Release

•

Interactive Upgrade Guide (SM_931_Interactive_Upgrade_Guide.zip)
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•

Upgrade Guide (in PDF format)

•

Upgrade Assessment Toolkit User Guide

•

Mobile Applications User Guide

•

Knowledge Management Search Engine Guide

•

Online help (SM9.31_help.zip)

•

Open Source and Third-Party License Agreements

About the updated Service Manager 9.30 Interactive Installation Guide
This release includes an updated version of the Service Manager 9.30 Interactive Installation Guide. Some
document fixes and enhancements have been made to this document; this document is still based on Service
Manager 9.30. However, KM Solr Search Engine installation and configuration information has been moved
from this document to the Service Manager 9.31 Knowledge Management Search Engine Guide, which
applies to the Service Manager 9.31 Solr Search Engine.
How to access PDF manuals from the online help
A large number of PDF manuals (Processes and Best Practices Guide, Web Services Guide, Document Engine
Guide, etc.) are embedded in the online help. You have several ways to access them:
•

If your online help is deployed on a web server and accessible from a URL like
http://<web_server_host>:<port>/SM_help, you can access a list of embedded PDF manuals from this
URL: http://<web_server_host>:<port>/SM_help/Content/Resources/PDF

•

Search the online help or use document links in the help

•

From the SM9.31_help.zip\Content\Resources\PDF folder

Important: PDF manuals embedded in the online help may be updated after the initial release. To check for
recent updates or to verify that you are using the most recent edition, visit the following URL:
http://h20230.www2.hp.com/selfsolve/manuals. You can download the latest version of a PDF manual to
replace the old version in your online help (in the PDF folder described above) so that you can keep your
online help up-to-date.
How to update your online help
To deploy the new online help, extract the SM9.31_help.zip file, and then deploy the content in a new
folder or simply replace the entire help content in your existing folder with the new version. For detailed
instructions, see the Service Manager 9.30 Interactive Installation Guide.

Service Request Catalog Documentation
•

Interactive Installation Guide (SRC_1.4_Installation_Interactive_Guide.zip)

•

Deployment and Sizing Guide

•

Customization Guide

•

Online Help (embedded in the product)

•

Open Source and Third-Party License Agreements
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Support Matrix
The Service Manager 9.31 Support Matrix document includes support matrix information for both Service
Manager and Service Request Catalog 1.4. The document is available from:
http://support.openview.hp.com/sc/support_matrices.jsp

Certifications
•

VMWare vSphere 5
VMWare vSphere 5 (VMWare ESXi 5.0) has been certified in this release, with vMotion supported.
As the response time will increase during the vMotion, it is important to consider tuning SM’s Failure
Detection (FD) settings to prevent the premature removal of SM nodes from the cluster. This is
especially important if you have set the FD setting to a value smaller than the default (Default:
timeout=10 seconds; max_tries=5). The FD settings are defined in udpcluster.xml and udp.xml located in
the Service Manager server’s RUN directory.
For information about vMotion recommendations and known issues, see whitepaper Service Manager
9.31 vMotion Test Report, which is available from the HP Software Support web site at:
www.hp.com/go/hpsoftwaresupport

•

SQL Server 2012

•

Firefox 15
Firefox 15 has been certified on the Service Manager Web tier and Service Request Catalog in this
release.

•

Oracle Enterprise Linux 6.3/6.2/6.1/6.0

•

Red Hat Enterprise Linux 6.3/6.2/6.1/6.0

Enhancements
This release includes the following enhancements.

Service Manager Enhancements
SCR

Module

Problem

Fix

QCCR1E77839

Server

SRC has an issue in which it cannot
authenticate a password if there is a
special character, such as a colon (:),
entered into the password field.
Note: SRC cannot use the same
encryption algorithm as the SM Windows
or Web client.

Refined the protocol between
the SRC client and the SM
server.
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SCR

Module

Problem

Fix

QCCR1E76409

Server

The SM server cannot read the language
parameter in the SOAP header of a Web
Service call and respond with proper
localized messages. Because of this
limitation, when a user logs on from
Mobility with a non-English client, the
messages are not localized.

When users log on from
Mobility with a non-English
client, the messages are
properly localized.

QCCR1E76796

Server

Service Manager needs to provide the
ability to turn on debugging dynamically.

Service Manager now
provides the ability to turn on
debugging dynamically for a
user session or scheduler.

Applications

For more information, see
Dynamic Debugging of User
Sessions or Schedulers.
QCCR1E76016

Server

Search results do not show the verb with
suffix "suru" when users search for the
related Japanese noun.

Search results now show the
verb with suffix "suru" when
users search for the related
Japanese noun.

QCCR1E58439

Applications

There is a need for proposing relationship
changes for CIs that need to be approved
and only be processed after a defined
change workflow has been followed.
Currently it is only possible to change
relationships immediately but not to plan
them for future change.

Users now can plan CI
relationship changes using
the "Expected State" Wizard,
which is used for both CI
attributes and relationships.
For more information, see
Planning CI Relationship
Changes from a Change
Record.

QCCR1E76329

Applications

When a user searches "Order from
Catalog" to search the Catalog by using
keywords, the search retrieves items as
well as categories and subcategories.
There should be an option to show only
bundles and items when searching in
"Order from Catalog."

There is now an option (the
Bundles and Items only
checkbox) to show only
bundles and items when
searching in "Order from
Catalog."

QCCR1E76985

Applications

When a search for terms like "server
monitoring" is performed, the search
produces results for either "server" or
"monitor" separately (server OR
monitoring). Instead, the search results
should be for the combined search terms
(server AND monitoring).

Now two radio buttons are
available to change the search
mechanism to AND or OR:
Any of these words: Search
for catalog items that contain
any of the keywords you
enter.
All of these words: Search
for catalog items that contain
all of the keywords you enter.

QCCR1E76093

Applications

The UCMDB Content Pack should be
merged into the Service Manager OOB
functions.

Merged the UCMDB related
functions into SM OOB and
enhanced the UCMDB
Integration Guide.
27

SCR

Module

Problem

Fix
For more information, see
UCMDB Integration
Enhancement.

QCCR1E79068

QCCR1E78234

Windows
Client

Web Client

The Enterprise Collaboration integration
only supports the Incident Management
and Service Desk Interaction modules.
Records in the Change Management
module do not have conversations saved
or linked to them. Change Management
users also expect to see this collaboration
feature in the Change Management
module.

The Enterprise Collaboration
integration now also supports
the Change Management
module. Conversations can be
created and saved in Change
or Change Task records.

In the Web client, when users have an
array for which they have to select CI's,
the multiple selection feature is available
in device.qbe.g. When they click the
checkbox "check all" and then click on
one single marked CI, all records are
transferred to the Change or Incident
that they are updating. However, there
is no mechanism to deactivate the "Check
All" checkbox, retain the "Fill Selected"
button, and then be able to check single
CI's.

Users can now deactivate the
"Check All" checkbox but
retain the "Fill Selected"
button and then check single
CI's, by clicking single rows
(not their first-column
drilldown links).

For more information, see HP
Service_Manager
Collaboration (SM
Collaboration)

Service Request Catalog Enhancements
SCR

Problem

Fix

QCCR1E78743

Add Service Request Catalog (SRC)
support for fulfillment approvals (for
example, change and request management
approvals). Currently, SRC only supports
interaction approval.

This feature is implemented as of SRC 1.4.

QCCR1M2569

In the SRC client, prices display as 0.00
when a catalog item does not have a price
value in the underlying SM database.
SRC always passes the date/time field
value as it is specified in user selections.
This behavior does not change even when
there is a "Mandatory" requirement for
this user selection.
Enhancement Request: The customer
would like the full screen to be available
for inputting customer information when
submitting a catalog request.
Enhancement Request: Make SRC screen
blurring on submit request configurable.

Prices are no longer displayed when the SM
value is NULL.

QCCR1E75761

QCCR1E78729

QCCR1E78728

The Date/time field will now allow an empty
value if a field is not mandatory.

The UI design has changed in the latest
version of SRC to use space more efficiently.
The UI design has changed and the blurring
effect is removed.
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SCR

Problem

Fix

QCCR1M2376

This is an enhancement request for more
information on how to use SRC in different
languages.

QCCR1E78235

The "Who is the request for?" field in SRC
request submission page should be
removed or made read-only.

SRC derives its language specifications from
the default language specified in the enduser's Web browser. This is now specified in
the SRC Web Help for end-users. More indepth discussion of the language settings for
system administrators is discussed in the
Installation Guide.
The switch that makes the "Who is the
request for?" field editable is set to false by
default.

OOB SRC allows the requester to change
the service recipient (Who is the request
for?) while submitting the request. The
following issues have been identified when
User A submits the request for User B:

QCCR1E78956

QCCR1M3475

QCCR1E73794

The Interaction for this request has the
requester's name in both contact and
service recipient fields in SM.
The Requests created using this option do
not display in the recipient's dashboard in
SRC.
The system allows User A to submit
requests for User B that User B is not
entitled to.
The system enforces Interaction approval
(Line Manager Approval) based on the
requester instead of the recipient.
SRC contains the Request Inbox, where
the service requests and support requests
are listed. The title of the Service Requests
list is as follows: "Your subscription
requests". Some catalog items can be
linked to a subscription, but not all of
them will have a subscription. For these
items, the title is incorrect and confusing.
SRC loads Service Categories when the
user logs in. However, if the number of
Service Categories is high, the login
process can take a very a long time.
When an end user selects an informationonly item from the Support Catalog in
SRC, it displays the following information.
This information causes confusion to end
users, as they are not actually submitting
a request.

Changed the name to "Your Service
Requests" in Account Inbox.

Service Categories are now loaded after the
user logs in.
Removed this information for informationonly items.

-------------------------------------------------When you submit the request, provide this
information
Description:
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SCR

Problem

Fix

Describe what you need to solve your
problem.
Contact Information:
Tell us the best way to contact you.

QCCR1M996

Attachments:
Attach any related documents or
specifications.
-------------------------------------------------The SRC 1.20 documentation is full of
errors and missing information.

Documentation has been improved in the
Installation Guide and a new Customization
Guide has been created to provide more
thorough explanation of Service Request
Catalog features and configuration.

Fixes
This software release includes the following fixes.

Server
SCR

Problem

Fix

QCCR1E31861

Failed login count does not increase when
using LDAP. As a result, users who enter
their passwords incorrectly too many times
are never locked out.

Failed login count will increase when using
LDAP, and the account will be revoked if
the attempt count exceeds the specified
limitation.

QCCR1E32145

Search Results are inaccurate against the
operator table if an operator's Template
(systemplate) field has a value. The
operator record will not display in a
Search, even though the selection criteria
says it should.

Operator records that have a non-NULL
systemplate field now will merge the
template record before they are passed to
the query condition filter. In the old
versions, these records were passed to the
query filter before they merged the
template and were thus incorrectly filtered
out.
A new parameter (fetchnotnullsystemp) is
introduced in sm.ini. You need to set
"fetchnotnullsystemp:1" to enable the
template merge functionality. However, it
may cause performance issues if the
operator table has more than 10 thousand
records whose systemplate field is not
NULL.
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SCR

Problem

Fix

QCCR1E54795

Exporting a large data set (for example,
40,000 incidents) to Excel resulted in a
servlet crash with an out-of-memory error.

Added a limit as to how much Java heap is
expended for a large XML response. The
default threshold will be 50% of max Java
heap.

QCCR1E75022

There is a dedicated thread in the software
loadBalancer that periodically requests the
RTE Server to update the nodes
information. However, the timeout value
for this thread appears to be too small,
which prevents the node information from
being updated correctly. As a result, the
number of available nodes fluctuates
wildly.

To resolve this issue, the grouptimeout
parameter has been introduced in sm.ini.
This parameter allows you to configure the
timeout value (in milliseconds) for Jgroups
remote procedure calls. You can tune this
value to keep the number of available
nodes stable. Default is 1000, minimum is
300, and maximum is 10000.
It is recommended to set this parameter to
a minimal value as long as it can keep the
number of the available nodes stable.
Meanwhile, the network latency between
the web server and the SM server should
be small; otherwise the load balancer may
forward a request to a node that is not able
to handle the request due to network
latency.

QCCR1E75861

An array of structures nested within an
array of structures in a dbdict table does
not work in Oracle databases.

An array of structures nested within an
array of structures in a dbdict table works
as expected in Oracle databases.

QCCR1E75975

In a vertically scaled system, one of the
servlets hangs and a core file is generated
on the production server.
Every time a user logs in on the servlet, a
"Signal 11" error is generated, and most
times a core file as well.

The defect that caused the "Signal 11"
when connecting to an LDAP Server over
SSL has been fixed.

QCCR1E76056

Cannot search Change tickets with a
Change ID.

Now, tickets that have a Change ID can be
searched as expected.

QCCR1E76258

Memory Leak messages are found in the
log file after the Service Manager system
starts and then shuts down on Unix.

Fixed the memory leak after the Service
Manager system starts and then shuts
down on Unix.
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SCR

Problem

Fix

QCCR1E76399

Partial System Outage occurs when a node
in the cluster quit responding to requests.
This behavior occurs when the
Transparent Application Failover (TAF)
feature on Oracle is enabled.
When this issue occurs, the following
messages are logged repeatedly:

Service Manager now detects the TAF
configuration and prints warning messages
to the sm.log at startup.

9568468(36438057) 05/06/2012 13:50:37
RTE E Unable to parse date for column
SYSMODTIME
9568468(36438057) 05/06/2012 13:50:37
RTE E Incomplete record, could not
process data for table NUMBERM1 in
file number identified by key:
name="incidents"
9568468(28049409) 05/06/2012 13:50:37
RTE E Error in fetching sequence
number for file incidents
9568468(36438057) 05/06/2012 13:50:37
RTE E date format '06-MAY-12'
unrecognized in sqlda

The warning messages are listed below:

2852( 2844) 07/31/2012
13:06:34 RTE
!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
2852( 2844) 07/31/2012
13:06:34 RTE
ServiceCenter does
not support Oracle TAF. Please remove
TAF configuration
and restart ServiceCenter to avoid
running into outages.
2852( 2844) 07/31/2012
13:06:34 RTE
!!!!!!!!!!!!!!!!!!!!!
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!

QCCR1E76623

Signal 11 errors are still received when
SpiderMonkey executes Garbage Collection
even after a hotfix to address the problem
was applied.
However, the occurrence of the Signal 11
error is not as frequent as before and it
seems to occur only in the SMOO process.
Because of this, SM users can continue
without interruption.

This issue occurred when the functions of a
JavaScript package were enumerated.
Protecting the iterator from being freed
when enumerating the JS package
functions prevents the issue.

QCCR1E76875

JavaScript does not properly handle binary
data.

Added a new JS function, getBinary, to
retrieve the binary representation of a
field. Following is an example of using this
JS function:
var bb = new
SCFile("bbtosysattachments");
var rc = bb.doSelect("true");
var attachmentObj= new Attachment();
attachmentObj.value = bb.
getBinary("att_attachment")
attachmentObj.name = bb.att_filename;
attachmentObj.type = "excel";

QCCR1E77025

One of the SM Servers (nodes) is
generating core dumps and causes all
other servers to fail.

Now, when the rc cache is cleared, a flag
will be set. Before accessing the rc cache
again, this flag will be changed; If the flag
is set, accessing the cache will be skipped,
and prevent the Signal 11 error from
happening.
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QCCR1E77101

Investigate if any improvements can be
made in the timing of the following
messages, to avoid unnecessary actions by
the end user:

When the low memory condition is
detected, SM will call the JVM Garbage
Collection to decrease Java memory usage.
SM will not send a "low on memory"
message unless the server is still low on
java memory after garbage collection is
called.

"Server running low on memory, close
some application tabs and try again"
"Server running low on memory, relogin to
the system"
QCCR1E77126

When using "all of these words" in
Advanced Search, other forms of the
search term do not appear in the results.
For example, a search that includes the
term "ran" does not return results that
contain "run", "running" and "runs."

When using "all of these words" in
Advanced Search, different forms of the
search term appear in the results.

QCCR1E77312

The following warning message is recorded
incorrectly in the sm.log file:

The warning message will not be recorded
in the sm.log file.

"W could not find field "1" in dbdict for file
activity"
QCCR1E77305

Windows core dump file is very difficult to
analyze with Microsoft Visual Studio or
Windbg. The stack in the dump file is of
little use.

Improved the core dump file generation to
make it easier to analyze with Windbg.

QCCR1E77491

After applying a hotfix, a Signal 11 error is
still received but only during the SMOO
process.

No Signal 11 error is received during the
SMOO process.

QCCR1E77559

When applications use the SQLSelect RAD
panel, the associated database cursors are
left open.

Now when the panel exits, the statement
handle is closed as well as the cursor.

QCCR1E77589

Signal 11 errors and core dumps are still
being created after applying 9.30.p3.hf9.
This issue occurs when a column's name is
too long.

When a column's name is too long, an error
is recorded in the server log (sm.log) to
suggest the use of an alias.

QCCR1E77983

Using a view that executes a bad query
may result in a large memory leak. When
this occurs, servlets that have the
LowMem flag set to "Y" do not accept
sessions.

Fixed the memory leak when using a view
that executes a bad query.
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QCCR1E78435

Users have been reporting LDAP servers
respond slowly to SM 9.30. The issue
seems to occur because of the
DomainDnsZones.us.qdx procedure, which
should be ignored.
Other applications have had this issue and
the solution was to prevent the
applications from calling the
DomainDnsZones procedure. One way to
do this would be to have a parameter to
turn off LDAP_OPT_REFERRALS.

The openldap library has a problem when
calling the ldap_set_option() function to
turn LDAP_OPT_REFERRALS off with
parameter value LDAP_OPT_OFF saved in
a variable. This is resolved by a code fix.

QCCR1E78530

Executing a query that does not parse
results in a small memory leak.

This issue occurs because when the RAD
parser fails to parse a query, the parser
will process the query with escape chars,
and then try to parse again. However, the
first pass of query will not free the
allocated String which contains the parsed
result, which causes the memory leak to
occur.
The allocated string is now released, and
eliminates the memory leak.

QCCR1E78828

The BSM/SM integration using the CI
Alert Retrieval Service fails to parse JSON
data.

This issue occurred when the JSON file
length exceeded 32KB. The RTE code now
works as expected when the JSON file
length is larger than 32KB.

QCCR1E78959

When running the Mobility client with
memdebug:1 or memdebug:400, a memory
leak may occur when a user logs in and
then logs out.

The memory leak from the Mobility client
is fixed.

QCCR1E79274

A memory leak occurs in string.cpp.

Fixed the memory leak.

QCCR1E79393

A semaphore is not released and locks the
entire production environment, and the
releasesem SM command cannot release
the semaphore. An error similar to the
following occurs in the server log:

Removed the releasesem command,
because it cannot work on Windows or
Unix.

"WARNING: semaphore 9 held by pid
<xxx> tid <yyy> for <zzz>
milliseconds."
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QCCR1E80282

Some users cannot work in Service
Manager because their all lower-case
operator record name fields are being
changed when they try to log in to
SM. Specifically, the Service Manager
operator name field is populated with all
lower-case values. The sAMAccountName
field in Active Directory has mixed case.
When the operator logs in the operator
record name field will be updated with
mixed case. This issue occurs if the user
enters a wrong password during the log in.

The user name is no longer updated with
the mixed case username.

Web Tier
SCR

Problem

Fix

QCCR1E48469

The Web client ignores special characters
when retrieving a source record for hover
pop-up, and incorrectly displays records that
should not be considered a match.

The Web client now includes special
characters in searching for source records
to display in hover pop-ups, and correctly
displays the message ("No record found."),
if a match cannot be found.

QCCR1E57203

Focus is not returned to the Related Records
subsection of a record after opening and
returning from a related record. Instead, the
focus is set to the Assignment Group field.
The focus should be returned to the Related
Records subsection.

By saving the correct focus value on the
Web tier, the focus can be returned to the
selected related record.

QCCR1E59306

The navigation pane (system navigator)
cannot be reached by using the Tab key. The
Tab key can move the focus around all fields
on the screen, but the focus never reaches
the system navigator. There are no other
shortcut keys that can be used to access the
navigator area.

Users now can access the system
navigator, using different combinations of
keyboard shortcuts.
For details, see accessibility improvement
Accessing the System Navigator Using
Keyboard Shortcuts.

QCCR1E59445

Users receive no warning when JavaScript is
disabled in their web browser.

If JavaScript is disabled in a user’s
browser, the user is redirected to a
separate page displaying a message that
states Service Manager requires
JavaScript be enabled. In addition, the
user is allowed to navigate to the login
page again once JavaScript is enabled.

QCCR1E59611

Need to offer the accessible Web client for
disabled users. Messages and alerts are
classified with an icon. Those icons do not
have alternative text that can be used by
screen readers. All icons and graphical
elements should have an alternative text like
the following:

Alternative text has been provided for
icons used in messages and alerts.

<img src=??? alt=?[description]?>
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QCCR1E67814

Performing a copy of a field in a record by
using CTRL+C in the Web client locks the
record, even if lock on display is set to false
or NULL.

Performing a copy (CTRL+C) from a field
on a record in the Web client will not lock
the record.

Note: This behavior does occur in the
Windows client.
QCCR1E67966

Marquees are not displaying on Employee
Self Service (ESS) formats when the format
is first loaded.

Marquees now display as expected.

QCCR1E70795

When views in the Web tier are refreshed
multiple times, the columns of any views
that are grouped shrink.

When views in the Web tier are refreshed
multiple times, the columns of any views
that are grouped no longer shrink.

QCCR1E71520

The hover sub-form for the Affected CI field
has a scrollbar. This is inconsistent with
other hover sub-forms.

The sub-form width has been adjusted
properly to avoid the scrollbar.

QCCR1E73015

When a user follows a link from a Service
Manager HTML email, modern browsers
with tab browsing support open this link in a
new browser tab page by default. However, if
user has already logged in to the Service
Manager Web Client, the newly opened page
causes the original working page to
automatically log out. This may result in
front tier data loss depending on the
application modes of the two pages.

Changes have been made to allow only one
live Service Manager Web client in the
same Web browser session. Provide an
interactive page and options to the user to
determine how to proceed, and to give the
user an opportunity to save their current
work.
For more information, see Enhanced Web
Client Session Management to Prevent
Data Loss.

QCCR1E73498

When editing a field that allows a hover,
such as a contact on an Interaction, the hover
field data conflicts with the hover form. The
hover maintains the original information
regardless of whether the data in the field
has changed or is blank. Additionally, when
a user begins editing the contact data, the
cursor jumps to the end of the contact when
the first letter is typed.

When editing a field that allows a hover,
the hover form changes accordingly to
return correct data. Additionally, the
cursor stays in place while a user is editing
the field data.

QCCR1E75728

In the accessible Web client, the paging
controls and Count Records button do not
work. Because of this, users cannot navigate
through the pages.

In the accessible Web client, the paging
controls and Count Records button now
work well.

Note: This behavior only occurs in Internet
Explorer.
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QCCR1E76022

The Web client does not use appropriate
HTML headline tags (H1, H2 etc.) for HTML
headers. This is problematic for screen
readers used for accessibility.

The Web client now uses appropriate
HTML headline tags (H1, H2 etc..) for
HTML headers. To achieve this, in Forms
Designer, a new property "Heading Level"
is available for the following widgets:
- Label
- Wrap Label
- Group

Valid values of "Heading Level" are 1 to 6
(default is empty). Once a value is
specified, when rendered to HTML, the
text for these widgets will be enclosed in
the corresponding HTML headline tags (h1
to h6).

In addition, the tab title of the current
active tab page is enclosed with the <h1>
tag.

Important: These features are only
applicable to the accessible mode
(/accessible.do and /accessible_ess.do).
QCCR1E76395

Service Manager does not track sub-tabs
when a user starts a sequence of changes
(such as in a wizard). When the sequence is
finished, the previously active sub-tab is not
restored.

The active sub-tab will be restored after a
sequence of changes, except for specific
focuses that are set by SM Apps. The tab
containing the focused field will become
active when the focus is set by SM Apps.

Known issue in Internet Explorer 7: A
tab containing an HTML Editor often
becomes active after a sequence of changes.

QCCR1E76667

On the Web client login page, when you use a
non-English locale and log in with a wrong
username/password, the error message is
displayed as the following: "?????".

By directly outputting the error message
without conversion, the error message is
displayed in the Web client login page
correctly.

QCCR1E76793

If users are kicked off from the Service
Manager (for example, by the inactivity
timer), they cannot continue to operate in
BSM 9.12.

The LW-SSO token is no longer cleared
when users are kicked off from Service
Manager, so users can continue to operate
in other applications with LW-SSO
enabled.

QCCR1E77415

When a record contains special characters in
a multi-line text field, the Web client
converts the characters into their HTML
code representations in Print Preview.
For example, quotation marks are replaced
by &quot, and a greater than sign (>) by &gt.

Print Preview can display the quotation
and greater than markers correctly.
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QCCR1E77488

The auto-complete function for "select only"
combo box fields has incorrect behavior in
the Web client. For example, if first value is
"two" and the second value is "tw" in the Web
client, when you select "tw" and then click
anywhere, the auto-complete function
incorrectly uses the value "two."

The combo box now matches the whole
string before matching the prefix of the
available options.

QCCR1E77494

There is a hint when you highlight the "last
interaction" button in the Web tier:

Re-added key handling for the F5 key.
Now, the Alt-F5 key command (last
interaction) works as expected.

"Go to Most Recently Saved Interaction
Alt+F5".
However, nothing happens on clicking
Alt+F5. If you select the button via mouse
cursor, you will go to the last interaction as
expected.
QCCR1E79109

Web client images are not displayed at the
correct size when forms are first rendered in
the Web client of Service manager 9.30 Patch
3.

Images are rendered at the appropriate
size in the Web client.

QCCR1E79474

The first record in an associated record list is
always deleted even if the record you are
trying to delete is not the first.

The selected record is deleted as expected.

QCCR1E79840

No results are returned when using MySM
with non-English characters defined in a
RAD Query.

The correct records are returned.

QCCR1E80208

In the old style menus that were used to
navigate Service Manager, the JAWS screen
reader reads the following when hovering
over the icons for Service Desk, Incident
Management, and similar:
"OP 16 /cm graphic on mouse over link
graphic."

This issue occurs because the image and
the link have the same function. This issue
has been resolved by setting the image so
that it cannot receive focus.

Windows Client
None.
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QCCR1E80005

Search results are not constrained by the
"Max Number of Documents Returned from a
Search" setting in a KM environment record.
The Search result count is wrong.

The behavior of the pagination function
has been changed to prevent this issue.

QCCR1E80049

An unexpected page is displayed after you
search Incidents with the "Autoformat Date
View" view.

Incident qbe list is displayed after you
search Incidents with the "Autoformat
Date View" view.

QCCR1E80035

The Approval Log is uneditable.

The Approval Log is now editable.

QCCR1E80053

The Cancel button does not work as expected
in the Incident qbe list.

The Cancel button works as expected in
the Incident qbe list.

QCCR1E79689

When searching knowledge from an
Interaction record and then clicking the Use
Solution button in a knowledge document, a
JavaScript error occurs:

The JavaScript error will no longer display
in the kmdocument page.

Process panel run.pre.exp in RAD
se.call.process encountered error in
line 12 (se.call.process,run.pre.exp)
Cannot evaluate expression
(se.call.process,run.pre.exp)
Cannot evaluate expression
(se.call.process,run.pre.exp)
Script <UNKNOWN> line 4: ERROR
TypeError: vars.$query has no
properties at char 1
Unrecoverable error in application:
se.call.process on panel run.pre.exp

QCCR1E79969

The Request for field cannot be re-selected
due to the operator validation.

The request for field can now be reselected.

QCCR1E79584

The functions, Export to Text and Export to
Excel, do not work in Service Catalog QBE
lists.

The functions, Export to Text and Export
to Excel, now work as expected in Service
Catalog QBE lists.

QCCR1E79520

When you select the "Contact Full Name"
field in a QBE list, the query will contain one
join table and is not handled properly.

The join table scenario is now handled
properly, and the query is appended to the
correct table. Therefore, the "Contact Full
Name" field appears in the QBE list as
expected.

QCCR1E79324

A full re-index on the knowledge library fails
if there is an empty default locale.

The default locale is set to "en" for English
if user's login language code is not set.

QCCR1E78966

Columns that were added when a view was
created are not displayed.

Columns that were added display correctly
when a view is created.
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QCCR1E78794

Users cannot set an empty value for
assignee.

Users can reassign incident assignee in the
Mobility console.

QCCR1E78591

Service Request Catalog (SRC) does not
accept case-insensitive login.

QCCR1M4186

Service Manager allows a user to check
Subscription for a Support Catalog Item.

QCCR1E77985

After setting up Mandanten security, the
order on behalf feature does not consider the
Mandanten settings of the user we order for.
This behavior occurs when special additional
input is requested by using the User Options.
This creates a major security
issue, because the data cannot be correctly
validated. Additionally, because SRC caches
the data, the system shows only the data
from the cache of the logged in user, but does
not start a new query for the person for
whom we order on behalf of.
An Error record appears in the schedule
table when closing an Incident which is
related to an Interaction. The $allow.save
equals false statement prevented the
Incident from being updated.

This issue occurs because of the JavaScript
ScAPI_svcCatOperator
canRequestOnBehalf() function. The
JavaScript function has been modified so
that SRC now accepts case-insensitive
login.
Modified format svcCatalog.item and
related formatctrl to disable the "Create
Subscription" check box when it is a
Support Catalog item.
The getOptionsLookup function in the SRC
API has been modified.

QCCR1E77825

QCCR1E77640

QCCR1E77586

When submitting a new interaction request,
the start time of SLA is not calculated
correctly.
If you wait for more than 5 minutes after an
interaction was created, and then update and
save the interaction, the SLOs are displayed
incorrectly. However, if you make the update
before the 5 minutes passed, then the SLOs
appear as expected.
The caption on Config Change files is still not
always shown even after applying a fix.

QCCR1E25301

Error occurs when processing the cm3rin
eventin record if an array of structures is the
last field in the cm3r dbdict.

QCCR1E31207

Focus is not maintained on Advanced Filter
tab of the Search screen after adding filter
criteria. The applications appear to not keep
track of the focus in this case.

Changed the background status to set
$allow.save=true and therefore to pass the
validation.

Now, when the Interaction is escalated, the
SLOs are related and will be active and
display as expected.

This issue is resolved from the application
patch side. The am.join.query process has
been modified to properly set the
$join.query local variable to true when
there is already a CI type selected.
No error occurs when processing the
cm3rin eventin record.
Focus is set to the Filter tab when the
wizard exits.
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QCCR1E5878

When adding filter criteria, a fill value
sometimes displays incorrect values when
using a multi-level field chooser. The link is
generated by the filter based on field type.
However, for a related object such as a mutlilevel field chooser, the link does not apply.

The fill value will display correct values
when using a multi-level field chooser.

QCCR1E31628

The context search wizard does not work
properly on a non-English system. Selecting
from the list of context definition actions fails
to take you to the next appropriate screen.
Instead, you are prematurely exited out of
the wizard and taken back to the previous
screen.

The context search wizard works properly
on non-English systems. Selecting from the
list of context definition actions takes you
to the next appropriate screen.

QCCR1E55084

When saving a change record that has a nonnumeric value in the EXT. Project Ref field
and the RDBMS is Oracle, the following
error message is received:
"sqociExec error: sqlcode=1722
message=ORA-01722: invalid number"

Added a Format Control Validation entry
that prevents users from entering nonnumeric values.

QCCR1E55765

When a relationship between a problem and
a known error record is deleted using the
Options Menu in a problem record (click
Related > Known Error > View, select a
related known error record and then click the
Delete button), Service Manager is not
clearing the parent.problem field in the
known error record. This causes an issue
when someone tries to close the problem
record.
Note: There is a RAD routine called
check.open.related that is called from the
rca.close Process record in the rootcause
object record that checks to see if there are
any open known errors before it allows you to
close the problem. The RAD routine checks to
see if the parent.problem record is populated
in the known errors.

When a relationship between a problem
and a known error record is deleted using
the Options Menu in a problem record, the
parent.problem record in cleared in the
known error record, so that the user can
successfully close the problem.

QCCR1E59338

Calculating data intervals using the RAD
application "calendar.calc.interval" can
return incorrect results if the holiday records
are not in chronological order.

Added a sort field as start.date in
get.holiday panel of the
calendar.calc.interval application.

QCCR1E67341

Copying a closed change task record can
result in an open task associated to an
invalid change phase.

Copying a change task is allowed only if
the current phase of the relevant change
matches the category-phase definition for
the task category.
Note: This fix does not work if you have
Process Designer Content Pack 9.30.1
installed. See Process Designer Content
Pack 9.30.1 Limitations.
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QCCR1E69389

The cc.save.incident RAD application is
missing the check.bg and check.bg.update
panels.

The application and code dbdict contents
are now consistent for RAD application
"cc.save.incident".

QCCR1E70107

Activity Type cannot be localized.

Activity Type (activity.name) can now be
localized.

QCCR1E70106

Closure Code cannot be localized.

Implemented necessary changes to ensure
localization of Closure Code (Resolution
Code).

QCCR1E71099

Users need to display Value Lists instead of
the data directly retrieved from the database
in a QBE list when adding a field by using
Modify Columns.

Value Lists can be displayed instead of the
data directly retrieved from the database
in a QBE list when adding a field by using
Modify Columns.
Note: This issue requires fixes at both the
server and applications sides. See server
fix QCCR1E71099 in the 9.30p5 Release
Notes.

QCCR1E71139

When Service Manager is configured to use
LDAP as the authentication data source, the
user is still forced to change the password if
the user is expired in the local database.

When Service Manager is configured to use
LDAP as the authentication data source,
the user will not be forced to change the
password if the user is expired in the local
database.
The fix is also available as an unload file,
QCCR1E71139_SM930P5_SM930.unl,
which can be obtained from the server’s
platform_unloads directory.
Note: This issue requires fixes at both the
server and applications sides. See server
fix QCCR1E71139 in the 9.30p5 Release
Notes.

QCCR1E73115

When an operator logs into ESS by using a
'Self service' role, the license report (sm reportlic) shows that the ESS user consumes
an Incident Management, Service Desk,
Problem, Change, and Knowledge Licenses.
However, an ESS user should only consume
a Limited Login License.

ESS users now only consume a Limited
Login License.

QCCR1E73386

Edge names do not display correctly when
viewing a relationship diagram.

QCCR1E73516

When creating a new interaction or a selfservice ticket, the following error is logged
intermittently in sm${portnumber}.log:
"The record being added contains a
duplicate key."

This issue occurred because only the
downstream CI name was used to search
for a CI relationship. This made all edge
names the same. Now, both the
downstream and upstream CIs are used to
determine a specific cirelationship.
Now, the database is queried to check
whether a record already exists before
trying to insert new records to DB. This
behavior avoids the duplicate key error.
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QCCR1E73711

The Approve button does not appear in the
Mobility client if there is an expression that
contains an "=" under the "Approval
Controls" section of a Change phase record.
The Windows and Web clients both display
the Approve button correctly.
When creating a Knowledge Document by
using the 'external' doctype, the Preview
button does not show the contents of the file
being used. Instead, the HTML viewer is
blank.

The Mobility client now displays the
Approve button correctly.

QCCR1E74162

Once an external type of Knowledge
Document has been submitted or
published, clicking the Preview button
brings up a dialog, asking if the user wants
to save the document in order to continue
to preview. Once the user clicks OK, the
document is saved, and the user can click
the Preview button to preview it.
When a user tries to search without
specifying a library, a message appears to
tell the user to select one or several
knowledge libraries.
If the user does not select a library, the
search result is empty.
The KM Search Engine should search for
Arabic documents by keyword.

QCCR1E74683

Running a search without specifying a
library will return the following message:
"Search Failed".

QCCR1E74812

When performing an advanced search with
the Query Language and Locale set to
Arabic, all Arabic locale documents are
returned in the search results regardless of
the keyword entered.

QCCR1E75201

When submitting a Service Catalog request,
Service Manager creates multiple identical
schedule records.
The "As Delegate?" column value in the
consolidated approval inbox
(approval.inbox.display) form always shows
YES, regardless of whether the approver is
approving as a delegate or not.
Custom alerts are not removed from the
schedule table after an Incident is closed.
Images in the Page Gallery of MySM are
missing.
A knowledgebase search performed in ess.do
will log out unexpectedly if the search server
is not configured.

When the trigger executes a check is now
made to verify whether there is a need to
create the SLA schedule.
The "As Delegate?" column value in the
consolidated approval inbox
(approval.inbox.display) form always shows
the correct value.

Exception calendar in the Scheduled
Maintenance module does not work correctly
when the timezone was set in the task.
Hanging locks on parent records such as SLA
or cm3r.
The order of expressions in the
se.external.action RAD needs to be adjusted
to allow customization of response messages
for Web service calls.

Scheduled Maintenance works correctly
with exception calendar and timezone.

QCCR1E75217

QCCR1E75310
QCCR1E75455
QCCR1E75763

QCCR1E75800
QCCR1E75854
QCCR1E75852

Custom alerts will be removed from the
schedule table after an Incident is closed.
Images of the Incident and Interaction
labels are shown correctly.
A knowledgebase search now shows
a dialog with following message: "Could not
connect to Search Engine, please verify
settings".

The parent records are unlocked as
expected.
Moved the message retrieve statements to
the end of panel. This will help to receive
all messages, including the customized
ones.
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QCCR1E75862

Submitting a Service Catalog request creates
identical schedule records.
RAD sm.update.affected.services still
performs unnecessary update as a result of
faulty condition.
When a matching.ci structured array field on
a Known Error record is populated and then
saved, the following validation error is
received:

Duplicated schedule records will no longer
be created.
The RAD application performs update only
when necessary.

"Please provide an update."
After the validation has been resolved (that
is, the update is provided), the data in the
matching.ci field is not saved correctly. The
data is saved in the following format:

{{["adv-afr-copier-fin"]}}

QCCR1E76007
QCCR1E76122

QCCR1E76088

QCCR1E76161

{{"CI NAME"}}

For example:

The Relevancy score increases automatically
when you return to the previous page on the
Search Knowledgebase screen.

The Relevancy remains unchanged.

The Mass Approve functionality approves all
tickets instead of just the ones that were
selected.

Now, the Mass Approve button functions
as follows:

QCCR1E76227

In the Mobility client, the incident/change
Priority and Urgency strings are all English,
even when a non-English language is
selected.

QCCR1E76285

With a Knowledge Base of 500K documents
or more, the KMUpdate process will take
many hours each pass to calculate how many
documents it may need to index. This issue
seems to be caused by a design flaw in the
counting algorithm in the
KMCollection_Update script library record.
When an approver is logged into the ESS
Web client as sdapprover (or other
approvers) and then attempts to approve a
request that has been modified by other
users, there is a message that explains the
record had been modified and will be
reloaded. However, the reloaded approval list
no longer shows the interaction.

QCCR1E76420

The data structure has been formatted to
the following: {{[]}}

•

If two or more records are selected in a
list, the Mass Approve function will
approve only the selected records.

•

If one or no records are selected in the
list, the Mass Approve function will
approve all the records in the list

Implemented the feature to support
localization.
Note: This fix is also available as an
unload file. See Unload Files Included in
Current Patch.
The design flaw is fixed, and results are
now returned in a much shorter time.

Modified RAD approval.approve to
temporarily suspend the normal approval
process while detecting whether the cart
has changed.

Note: The request is approved.
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Problem

Fix

QCCR1E76467

When users save an Incident that has an
outage start time during a different outage
time for the same CI, they receive several
error messages.
Alert Time has an incorrect value in Incident
Alert records if a non-24 hour Work Schedule
is specified.
When updating a probsummary record from
the Scripts tab of the controlerror format, the
following error is received:
"Source file variable is not a
relation."
The exit and action variables limit the
functionality of RAD se.external.action.
Additionally, the Web service may return an
error if the RAD is not called with specified
parameter(s).
Cannot execute the se.call.process RAD
Application by using the Application Pass
Through option in Web Services.
In SRC, there is more than one subscription
record under a bundle.

When users save an Incident that has an
outage start time during a different outage
time for the same CI, they no longer
receive any error messages.
Alert Time is calculated correctly with any
work schedule specified.

Alerts are not being scheduled if the status of
the Problem Task is Past Due and the alert
has already run.
The caption on Config Change files is still not
always shown even after applying a fix.

Alerts will regenerate if the due date is
updated and status is past due.

QCCR1E76566
QCCR1E76700

QCCR1E76862

QCCR1E76859
QCCR1M3906
QCCR1E77177
QCCR1E77586

QCCR1E77640

QCCR1E77825

When submitting a new interaction request,
the start time of SLA is not calculated
correctly.
If you wait for more than 5 minutes after an
interaction was created, and then update and
save the interaction, the SLOs are displayed
incorrectly. However, if you make the update
before the 5 minutes passed, then the SLOs
appear as expected.
An Error record appears in the schedule
table when closing an Incident which is
related to an Interaction. The $allow.save
equals false statement prevented the
Incident from being updated.

This issue was resolved by changing the
$file thread variable to a local $L.file
variable in the pm.eval.alerts RAD
application.
Now, if the RAD application that is
invoked does not have a "$L.exit"
parameter specified, the value of $L.exit is
set to the default value.
The specified RAD can be executed by
using the Application Pass Through option
in Web Services.
A bundle that has a subscription record
cannot be submitted.

This issue is resolved from the application
patch side. The am.join.query process has
been modified to properly set the
$join.query local variable to true when
there is already a CI type selected.
Now, when the Interaction is escalated, the
SLOs are related and will be active and
display as expected.

Changed the background status to set
$allow.save=true and therefore to pass the
validation.

45

SCR

Problem

Fix

QCCR1E77985

After setting up Mandanten security, the
order on behalf feature does not consider the
Mandanten settings of the user we order for.
This behavior occurs when special additional
input is requested by using the User Options.
This creates a major security
issue, because the data cannot be correctly
validated. Additionally, because SRC caches
the data, the system shows only the data
from the cache of the logged in user, but does
not start a new query for the person for
whom we order on behalf of.
Service Manager allows a user to check
Subscription for a Support Catalog Item.

The getOptionsLookup function in the SRC
API has been modified.

QCCR1M4186

Modified format svcCatalog.item and
related formatctrl to disable the "Create
Subscription" check box when it is a
Support Catalog item.
This issue occurs because of the JavaScript
ScAPI_svcCatOperator
canRequestOnBehalf() function. The
JavaScript function has been modified so
that SRC now accepts case-insensitive
login.

QCCR1E78591

Service Request Catalog (SRC) does not
accept case-insensitive login.

QCCR1E78794

Users cannot set an empty value for
assignee.

Users can reassign incident assignee in the
Mobility console.
Note: This fix is also available as an
unload file. See Unload Files Included in
Current Patch.

QCCR1E78966

Columns that were added when a view was
created are not displayed.

Columns that were added display correctly
when a view is created.

QCCR1E79324

A full re-index on the knowledge library fails
if there is an empty default locale.

The default locale is set to "en" for English
if user's login language code is not set.

QCCR1E79520

When you select the "Contact Full Name"
field in a QBE list, the query will contain one
join table and is not handled properly.

The join table scenario is now handled
properly, and the query is appended to the
correct table. Therefore, the "Contact Full
Name" field appears in the QBE list as
expected.

QCCR1E79584

The functions, Export to Text and Export to
Excel, do not work in Service Catalog QBE
lists.

The functions, Export to Text and Export
to Excel, now work as expected in Service
Catalog QBE lists.
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Problem

Fix

QCCR1E79689

When searching knowledge from an
Interaction record and then clicking the Use
Solution button in a knowledge document, a
JavaScript error occurs:

The JavaScript error will no longer display
in the kmdocument page.

Process panel run.pre.exp in RAD
se.call.process encountered error in
line 12 (se.call.process,run.pre.exp)
Cannot evaluate expression
(se.call.process,run.pre.exp)
Cannot evaluate expression
(se.call.process,run.pre.exp)
Script <UNKNOWN> line 4: ERROR
TypeError: vars.$query has no
properties at char 1
Unrecoverable error in application:
se.call.process on panel run.pre.exp

QCCR1E79969

The Request for field cannot be re-selected
due to the operator validation.

The request for field can now be reselected.

QCCR1E80005

Search results are not constrained by the
"Max Number of Documents Returned from a
Search" setting in a KM environment record.
The Search result count is wrong.

The behavior of the pagination function
has been changed to prevent this issue.

QCCR1E80049

An unexpected page is displayed after you
search Incidents with the "Autoformat Date
View" view.

Incident qbe list is displayed after you
search Incidents with the "Autoformat
Date View" view.

QCCR1E80035

The Approval Log is uneditable.

The Approval Log is now editable.

QCCR1E80053

The Cancel button does not work as expected
in the Incident qbe list.

The Cancel button works as expected in
the Incident qbe list.

QCCR1E75788

[SRC API]: Searching for all records in the
contacts table when using a newly created
lookup field in SRC does not work as
expected. Only 32,678 records are returned,
when more than 80,000 are available in SM.

All expected results are now returned.

In the Windows client all the expected
results are returned (> 80,000).
QCCR1E76218

[SRC API]: If a user modifies a request while
the request is being approved by a manager
or approver, the modifications can be
submitted, but not updated for the manager.
Therefore, the manager can inadvertently
approve the new requests.

The SRC API has been modified to detect
changes to the current approval and return
proper return code to the SRC UI.
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Problem

Fix

QCCR1E76248

[SRC API]: When a catalog item in Service
Manager has a Recurring Costs value
without a recurring type (Per week, for
example), the catalog item is displayed in
SRC with a recurring price but without any
of the following values: hourly fee, daily fee,
weekly fee, monthly fee, or yearly fee.

The SRC API now handles the Recurring
Costs and Per fields as follows: If either
field is empty, a Null is returned for both
fields; if both fields have a value, their
correct values are returned.

QCCR1E76307

[SRC API]: Comments cannot be added to
approval info in SM from ApproveApproval
API even if the "Require appr. comments" is
checked in Object.

The comments can be sent properly by
setting the appropriate variable.

QCCR1M3977

[SRC API]: The CreateAllCatalog
functionality takes too much time for a large
catalog.

A new API has been substituted for the
original one and resolved the performance
issue.

Upgrade Utility
SCR

Problem

Fix

QCCR1E73717

After upgrading from SM 9.21 to SM 9.30 by
using Upgrade Patch 3, the following error
message is logged in the upgrade.log:

The code was changed to provide the
missing arguments to the "Building
Distribution object for %S %S" message
template.

"This message did not provide enough
arguments:Building Distribution object
for %S %S"

Knowledge Management Solr Search Engine
None.

Mobility Client
SCR

Problem

Fix

QCCR1E71958

In the SM Mobility interface, a ticket cannot
be reassigned to another Assignee by using
the mobile client. The ticket can be assigned
to another group, but there is no way to
reassign or assign it to an operator/assignee.
The assignee field cannot be modified at all.

In the SM Mobility interface, users can
reassign a ticket to another Assignee via
the mobile client.
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Problem

Fix

Service Request Catalog
SCR

Problem

Fix

QCCR1M1241

After a request is submitted for an item with options and
you review the Interaction of the end user, the options
cannot be displayed fully if the option label is too long.

Options can now be displayed
fully.

Additionally, for a user option that is defined by check
box, the cost is displayed as zero (0) even if the cost is
not defined.
QCCR1M1374

One SRC UI operator session may initiate multiple SM
sessions.

One SRC UI operator now will
only have one corresponding
SM session.
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Problem

Fix

QCCR1M1622

SRC provides the option to alter the value displayed in
the SRC interface for contacts. By updating the
applicationContext.properties file and updating the
src.sm.contactListDisplayPattern parameter, the value
displayed for a contact can be changed from
contact.name to FullName, FirstName, LastName,
ContactName, or Name.

The display pattern will only be
used for display. SM will take
the contactName for
verification and storage.

If the display pattern is changed, SRC does not pass the
contact.name value in the record and instead stores the
displayed value. As a result, the creation of the SM
ticket fails on submit.
The following is the relevant information from the
applicationContext.properties file:
Contact Display Property
The default value for the contact name search result list
is ContactName ${C}. If you want to display a different
format, specify a different value. For example, to display
ContactName (FirstName.LastName), you can specify
the parameter as follows:
src.sm.contactListDisplayPattern=${C}( ${F}.${L})
Pattern
${N} -:
${C} -:
${U} -:
${F} -:
${L} -:

for contact search result list
Name
ContactName
FullName
FirstName
LastName

src.sm.contactListDisplayPattern=${C}

Note: This is necessary because contact.name is the
unique key for contacts in Service Manager. However, in
the real world, it cannot be used for the full name of the
contacts (or you could not have two contacts with the
same name).
In a large percentage of builds, contact.name is therefore
set to a truly unique value (often an HR ID or some other
number that an end-user would not be able to identify
for another person). SM can be tailored to allow users to
view and fill contact information based on full.name
(QBE lists display additional columns to allow a user to
select the correct contact should multiple contacts exist
with the same name).
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Problem

Fix

QCCR1E70757

When clicking on the email link inside Service Request
Catalog (SRC), extra characters are displayed, as shown
in the following example:

SRC will no longer show
escaped HTML characters.

Please%20provide%20responses%20to%20the%20followi
ng%20questions%20before%20submitting%20your%20ema
il%
20Project%20request%3A%0D%0A%0D%0APoint%20of%20Co
ntact%20for%20IT%20Relationship%20Management%20fo
r%
20this%20Project%20Request%0D%0AName%3A%0D%0APhon
e%3A%0D%0ALOB%20Name%3A%0D%0A%0D%0A1.%20Briefly%
20describe%20your%20business%20need%3A%20%0D%0A%0
D%0A2.%20Will%20this%20request%20require%20the%
20involvement%20of%20an%20External%20Vendor%3F%20
%20%0D%0A%0D%0A3.%20Is%20there%20approved%20budge
t%
20for%20this%20request%3F%20%20

QCCR1M1901

The SRC UI detailed description does not show correctly
and is truncated in some cases. A SOAP API call to
catalog item returns the data correctly, but the SRC UI
cannot display the data correctly.

Flex only supported a subset of
HTML tags. The SRC server
will now filter and convert
unsupported tags before
sending to Flex.

QCCR1M2142

Users cannot log in to SRC using a password that
contains a colon (:). The special character is causing the
current SRC credential pack incorrectly parsed in the
SM RTE.

Improved the way of packing
credential string so that the
string can be correctly parsed
in the SM RTE.

Documentation
SCR

Problem

Fix

QCCR1E75711

The vertical scroll bar on a sub-form in the
Web client does not appear. Instead, it
overlaps the other fields.

Updated the "Add a subform to a form"
topic in the online help with the following
note:
Limitation: If a subform contains only a
table, make sure that the table and
subform have the same height. This way, a
vertical scroll bar will appear for the table
if needed when the total height of all table
rows exceeds the specified table height. If
you specify a table height greater than the
subform height, the table rows may
overflow outside the subform and overlap
other fields on the form. If a subform
contains multiple widgets, make sure that
the subform height is set to be large
enough to hold all the widgets; otherwise
overlaps may also occur.
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Problem

Fix

QCCR1E76433

Particular error pages only display in the
WebSphere log but not in the browser. For
example, the "The session is busy, please try
again later" message that occurs when the
lockWaitTimeOut setting is exceeded.
This is because of a WebSphere problem ("An
error code always returns even though there
is a matching error exception type defined in
web.xml.")

Created knowledge article KM1449176,
which provides the steps to add a Web
container custom property setting when
deploying the web tier on WebSphere 6 or
later.
Also updated the Service Manager 9.30
Interactive Installation Guide to include
this additional step for WebSphere.

QCCR1E78706

After Service Manager (SM) was last
recycled (using SM 9.21 patch 5 RTE),
sometimes accessing an SM WSDL can cause
a signal 11 error. Also, SM is not processing
any web services transactions.

Added the following step to the “Prepare
your RDBMS” section in the Service
Manager 9.30 Interactive Installation
Guide:
For Oracle 11.1 or above only, disable ADR
tracing by turning off the diag_adr_enabled
parameter in the sqlnet.ora file:
diag_adr_enabled=OFF. ADR tracing is
enabled by default.
Note: An Oracle bug ("Multi Threaded OCI
Client Dumps Core After Reconnecting To
Database") is triggered when ADR tracing
is enabled. Once this bug is triggered, the
Service Manager server will crash every
time when setting up a connection to the
Oracle server.

When upgrading Service Manager, records
are prefixed with "OLD." However, these
records are not removed from the display
cache and display options in Service
Manager.

Added notes to instruct users that older
records must be cleared manually.

This is because of an Oracle bug ("MultiThreaded OCI Client Dumps Core after
Reconnecting To Database"), which exists on
Oracle 11.1 and above and is triggered when
ADR tracing is enabled. Once this bug is
triggered, the SM server will crash every
time when setting up a connection to the
Oracle Server.

QCCR1E83710
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Known Problems, Limitations, and Workarounds
This software release has the following known issues and limitations.

Service Manager Limitations and Known Issues
Note: The following is a cumulative list of known issues and limitations in Service Manager 9.31, including
those that already exist in previous releases (Service Manager 9.30 GA and patches).

Platform (Server, Web Tier, and Windows Client)
SCR

Problem

Workaround

Service Manager 9.31
QCCR1E84455

QCCR1E84453

When clicking the Line Items button on the
toolbar of a Quote record, its associated line
items do not appear in the list pane.

In Internet Explorer, the list of display
options cannot be displayed. If users execute
the do command in the Service Manager
command line and then click Search, a
blank page is displayed.
This issue does not occur in Firefox.

To solve this issue:
1

From the ToDo queue, select "Quote"
from the Queue field.

2

From the Quote queue, drill down to
the Quote record and click its Line
Items button.

There are two ways to solve this problem:
•

Use Firefox instead of Internet
Explorer.

•

This issue occurs only when users try
to open a record list in which one of the
columns is mapped to a field in a table
and the field name is in the list of
reserved keywords (see the list below).
Either changing the field name in the
table or removing the column from the
record list will prevent this problem
from occurring.
Reserved keywords: case, catch,
class, const, continue, debugger,
default, delete, do, else, enum, export,
extends, false, finally, for, function, if ,
import, in, with, while, void, var,
typeof, try, true, throw, this, switch,
super, return, resizeTo, null, and new
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Problem

Workaround

QCCR1E78426

In Internet Explorer 7 and 8, users may see a
warning from their web browser when
exporting a list to a text file:
To help protect your security,
Internet Explorer blocked this site
from downloading files to your
computer. Click here for options...
When users click Download File, the
following message may display:
To display the webpage again, the
web browser needs to resend the
information you've previously
submitted.
If you were making a purchase, you
should click Cancel to avoid a
duplicate transaction. Otherwise
Retry to display the webpage again.
When users click Retry, the following
message may display:
The Service Manager main
application is already open in
another browser tab. Please go to
that page to save your work, and
then continue.
When users click Continue, the file
downloading works correctly.

There are several ways to work around this
issue.

QCCR1E78840

You cannot start Service Manager (SM) if the
parent directory in which SM is installed
contains a special character, such as the
following: % @ &.

•

On the export to text screen, hold
down the Ctrl key when clicking the
OK button until the file download
dialog pops up.

•

Add the host of the web server or web
application server to the trusted sites,
and configure IE security settings to
enable the option Automatic
prompting for file downloads for
trusted sites (Security tab > Custom
Level).

•

Enable this feature by utilizing the
security policy or through a security
feature control registry key. For more
information, see
http://msdn.microsoft.com/enus/library/dd565669%28v=vs.85%29.as
px

To work around this issue, do not install
SM in a directory that contains special
characters.

Note: This behavior occurs when you are
using LW-SSO. The issue occurs because the
LW-SSO implementation in a third-party
product used in SM cannot correctly read a
directory that contains these characters.
QCCR1E75711

The vertical scroll bar on a sub-form in the
Web client does not appear. Instead, it
overlaps the other fields.

If a subform contains only a table, make
sure that the table and subform have the
same height. This way, a vertical scroll bar
will appear for the table if needed when the
total height of all table rows exceeds the
specified table height. If you specify a table
height greater than the subform height,
the table rows may overflow outside the
subform and overlap other fields on the
form. If a subform contains multiple
widgets, make sure that the subform
height is set to be large enough to hold all
the widgets; otherwise overlaps may also
occur.

QCCR1E80257

In Internet Explorer 7, the focus is
incorrectly set on the htmleditor when it
should be set on another field.

No workaround at this time.
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Problem

Workaround

QCCR1E69176

When you run "sm -shutdown -group"
directly on the SM Server, the smservice does
not stop.

Stop the Windows service or run a net stop
command (for example, C:\Program
Files\HP\Service Manager
9.30\Server\RUN>net stop "HP Service
Manager 9.30 Server").

Service Manager 9.30 or 9.30 patches
QCCR1E62584

In the Windows client on an Arabic operating
system, Arabic strings are displayed from the
left side of a field when and after you enter
them in the field.

Add a system property in client config.ini
file in installation directory to enforce
right-to-left.
Navigate to the Windows client
configuration file, <client installation
path>/configuration/config.ini. The default
is location is
C:\Program Files\HP\Service
Manager
9.30\Client\configuration\config.
ini.
Open the file and add this line at the end.
eclipse.orientation=rtl

QCCR1E28000

If the Equal sign (=) is the first character in
an array field, it will be truncated.
When Service Manager is running on Unix,
the legacy listener may log intermittent
signal 11 upon CIT initial connectivity test if
exec-shield is not set properly.

No workaround is available at this time.

QCCR1E57385

Use the workarounds to solve this issue.
Solution 1:
Connect Connect-It to the Web Services
connector instead of the Legacy Listener
connector.
Solution 2:
Before connecting Connect-It to the Legacy
Listener connector, do the following:
1

Add usethreading:0 in the sc.ini file,
which is located in <Service Manager
server installation
path>\LegacyIntegration\RUN.
Note: For 64-bit RedHat Linux servers
only, you can alternatively run the
following shell commands as root:
# sysctl -w kernel.exec-shield=0
# sysctl -w
kernel.randomize_va_space=0

2

Start the legacy listener.
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Problem

Workaround

QCCR1E32086

A Knowledge document with attachments
can have hypertext links to those
attachments. When a user needs to update
an attachment, the user may double-click the
attachment to open it from within the
knowledge document edit format, update the
attachment, and then save it. This will result
in a broken link to the file attachment

QCCR1E59371

In the web client, when a QBE form is
displayed as the result of a Fill operation,
many tab operations are required to position
the cursor on the list to select from when
using Internet Explorer, while only one tab
operation is required when using Firefox.
On an android phone, the username and
password labels in the log-in screen are
inside the text field.
When creating a new workflow using Process
Designer for the first time or after clearing
the browser cache, the workflow canvas will
be blank and not display an initial starting
node.

When a user needs to update an
attachment, the document needs to be sent
into the Knowledge Management workflow
so that administrators can edit the
document, view the attachment, and then
save the attachment to the desktop to
make changes to the attachment. Once the
attachment is updated, re-upload the
attachment to the knowledge document, relink to the attachment, and then re-publish
the document.
No workaround available at this time.

QCCR1E63548
QCCR1E64268

QCCR1E64377

QCCR1E65527

In the web client, when you open a
Configuration Item (CI) record, the CI label
does not show (or only shows for the first
time) in the CI Visualization (Relationship
Graph).
Some lines on the SM Client Uninstall
Feature Selection dialog are not fully
displayed

No workaround available at this time.
There are two ways to work around this
issue:
1

Load an existing workflow first. After
that, creation of a new workflow for the
first time will work properly.

2

Attempt to create a new workflow
again. The second attempt to create a
new workflow for the first time (or
after a browser cache flush) will
succeed.

No workaround available at this time.

Run the SM Client uninstaller from the
command line, using the -console option, as
follows:
1

Open a cmd shell and change to the
Client\_uninst subdirectory of the
ServiceManager install folder.

2

Run "uninstaller -console" in this
folder.

3

Follow all prompts.

Note: Repeated install/uninstall cycles can
cause the uninstaller to be installed into
the folder "_uninst2" instead.
If this happens, then use this folder and its
uninstaller.exe instead.
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Mobility Client
SCR

Problem

Workaround

QCCR1E84298

In the Mobility Client, if a user closes an
Incident and then opens the list of Incidents
assigned to the user, the closed Incident still
shows up in the list.

When opening the list of incidents assigned
to you, remember to click the 'Refresh'
button in the upper right corner, so that
closed incidents will disappear from the
list.

SCR

Problem

Workaround

QCCR1E77935

After an SLO is created, it is not attached
and displayed in the change record. The SLO
displays correctly only after the user logs out
and then logs in again.

Not available at this time.

QCCR1E84450

Archived incident records cannot be imported
into Service Manager.

Not available at this time.

Applications

Localization Limitations
SCR

Known Issue

QCCR1E58439

There is a need for proposing relationship changes for CIs that need to be approved and
only be processed after a defined change workflow has been followed. Currently it is only
possible to change relationships immediately but not to plan them for future change.

QCCR1E59076

Within a category or item display list, there should be the ability to sort based on an
internal priority rather than only in alphabetical order.

QCCR1E62656

JavaScript performance issues occur when a table contains too many rows.
In non-English environments, the “Execute Commands” function in System Navigator >
System Status does not work.

QCCR1E63806

Callback.type dropdowns have their values defined in formats instead of in a global list.

QCCR1E64688

The RAD scheduler queries too frequently.
In the English environment, a new parameter has been introduced (System
Information Record > General > Schedule Batch Size), which allows a System
Administrator to tailor the number of schedule records that can be processed by one
query.
However, in non-English environments, this configuration option is not activated and
therefore not user-configurable. This means all schedule records will be processed in one
query in non-English environments.

QCCR1E66140

A "Visible to Customer" update on a Change record is not replicated to the related
Interaction as a Visible to Customer update on an Incident record is replicated to the
related Interaction.

QCCR1E67750

In Knowledge Management, users cannot specify their search result sort preference,
other than by relevance score.
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Known Issue

QCCR1E70106

Closure Code cannot be localized.

QCCR1E70107

Activity Type cannot be localized.

QCCR1E72143

Clicking on the table lines of the Change form does not display the details of the
ApprovalLog.

QCCR1E72721

When you open an existing CI, the status of the CI can be saved with a wrong Statusvalue.

QCCR1E74326

There is currently no information presented by the user interface on the progress of a
Weblib crawl or indexing. If an error is encountered (for example, due to a proxy issue,
or a typo in the targeted URL, or a random survey popup requesting OK be clicked) there
is no indication of such issues in the user interface (the Manage Knowledgebase
function).

QCCR1E75490

If the same approver is identified in two different approval sequences of an approval
definition, the "pending approvals" listed appears to consolidate them to a single
approval sequence, and remove them from the smaller sequence id.

QCCR1E75800

Exception calendar in the Scheduled Maintenance module does not work correctly when
the timezone was set in the task.

QCCR1E76093

The UCMDB Content Pack should be merged into the Service Manager OOB functions.

QCCR1E76329

When a user searches "Order from Catalog" to search the Catalog by using keywords, the
search retrieves items as well as categories and subcategories. There should be an option
to show only bundles and items when searching in "Order from Catalog."

QCCR1E76985

When a search for terms like "server monitoring" is performed, the search produces
results for either "server" or "monitor" separately (server OR monitoring). Instead, the
search results should be for the combined search terms (server AND monitoring).

QCCR1E77409

When search results contain large documents (for example, software manuals in pdf
format), the search response time is significantly longer. This behavior occurs because
the content of the attachments is added to the "docbody_lang" field. Highlighting on this
field takes a lot more processing time to markup the entire document.

QCCR1E78009

SM should not allow a user to check Subscription for Support Catalog Item.

Process Designer Content Pack 9.30.1 Limitations
SCR

Problem

Workaround

QCCR1E67341

Copying a closed change task record can
result in an open task associated to an
invalid change phase.
Note: This issue has been fixed in the 9.31
applications. However, if you have Process
Designer Content Pack 9.30.1 installed
together with the 9.31 applications, the 9.31
fix will not work. Loading
QCCR1E78589_SM931_PD2.unl cannot solve
this problem.

No workaround available at this time.
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Problem

Workaround

QCCR1M5236

With Process Designer Content Pack 9.30.1
applied in Service Manager, after logging in
to SRC, an operator who has required change
security role (for example, a system
administrator) cannot select the Change
Management module for Approval
Delegation (on the Approval Delegation page,
the Change Management module is not
available from the Choose Type dropdown
list ).

Perform the following steps to resolve this
problem:
1 Log in to the Service Manager
Windows client.
2 Open the specific operator record.
3 From the menu bar, click Window >
Show View > Other… > RAD
Debugger, and then click OK to open
the RAD Debugger.
4 In the RAD Debugger command line,
execute command d
profile.change in $L.file to
get the Change profile of this
operator. If the operator record was
created before the PD Content Pack
was applied, a non-NULL value
should be returned; otherwise a
NULL value is returned.
5 If the command returns a NULL
value, execute x profile.change
in $L.file={"DEFAULT"}, and
then save the operator record. This
assigns the operator the DEFAULT
change profile.
6 Navigate to Tailoring > Database
Manager, open table “cm3profile”,
and then search for the Change
profile returned in step 4 or step 5.
On the profile’s Approvals/Groups
tab, select the Can Delegate
Approvals option.
7 Save the profile and log out.
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Problem

Workaround

QCCR1E78589

After applying Process Designer Content
Pack 9.30.1 and SM 9.31 Applications Patch,
some issues fixed in the SM 9.31
Applications reoccur.

Reconcile the differences between the
Process Designer Content Pack 9.30.1 (PD
CP2) and the 9.31 applications patch, and
then load QCCR1E78589_SM931_PD2.unl
into your system. This way the features in
both PD CP2 and 9.31 applications will
work properly.
For details, see Reconciling Differences
between Process Designer Content Pack 2
and the 9.31 Applications and Application
Unload Installation.
Recommended installation sequences
The following are recommended
installation sequences for different
combinations of the 9.30 content packs and
the 9.31 applications.
Installation Order
1. Survey Integration
2. 9.31 applications

1. PD CP2
2. 9.31 applications
3. QCCR1E78589_SM931_PD2.unl
1. Survey Integration

2. PD CP2
3. 9.31 applications
4. QCCR1E78589_SM931_PD2.unl
1. HTML Email
2. Survey Integration

3. PD CP2
4. 9.31 applications
5. QCCR1E78589_SM931_PD2.unl
Reconciling Differences between Process Designer Content Pack 2 and the 9.31 Applications
If you have already installed the Process Designer Content Pack 9.30.1, when applying the SM9.31
applications, a certain amount of renamed records will be generated. The following table lists these renamed
records. Make sure you keep the Process Designer 9.30.1 version (do not merge it with the SM9.31
applications). Loading QCCR1E78589_SM931_PD2.unl will help resolve the conflicts. See known issue
QCCR1E78589.
Note: If you tailored any objects listed in the following table, loading QCCR1E78589_SM931_PD2.unl will
overwrite your tailoring changes. To preserve your tailoring changes, you need to:
1

Before loading QCCR1E78589_SM931_PD2.unl, make a backup of your tailored objects.

2

Load QCCR1E78589_SM931_PD2.unl.

3

Merge the updated objects with your tailored objects.
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Object Type

Object Name

Application Cluster

cm.change.catphase

Application Cluster

cm3.last.task.process

Application Cluster

db.mass.functions

Application Cluster

display

Application Cluster

sla.refresh.active

Application Cluster

trigger.cm3t.post.edit

Object

cm3r

Process

cm.chg.cat

Process

cm.chg.phase

Process

template.init

ScriptLibrary

ApprovalUtil

ScriptLibrary

ChangeOperatorInfo

ScriptLibrary

changeManagement

ScriptLibrary

tableAccess

activityactions

Update Activitiescm3r

format

CM.change.approvalen

format

CM.change.approvalprepen

format

CM.change.closureen

format

CM.change.implementationen

format

CM.change.loggingen

format

CM.change.planningen

format

CM.change.reviewen

formatctrl

cm3r

formatctrl

cm3rcatphase.main

link

cm3r

Integration Limitations and Known Issues
UCMDB Integration
For a list of known issues and limitations of the UCMDB Integration, see the Service Manager 9.31
Universal CMDB Integration Guide, which is available from the online help.
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SM-BSM Downtime Synchronization
SCR

Problem

Workaround

QCCR1E83962

In an environment with Process Designer
Content Pack 2, Service Manager 9.31
applications and
QCCR1E78589_SM931_PD2.unl applied, the
SMIS (Integration Manager) Change
category/final approval phase validation
works incorrectly for the "Normal Change"
and "Emergency Change" categories, while
the outage calculation works properly.
The problem occurs because SMIS validates
the Workflow name while Process Designer
validates the description.

No workaround available at this time.

Enterprise Collaboration Integration (SM Collaboration)
SCR

Problem

Workaround

QCCR1E84711

Users cannot open an existing conversation
created by OMi.

No workaround available at this time.

This issue occurs in the following scenario:
•

Both Service Manager and OMi are
integrated with Enterprise Collaboration
(EC).

•

The OMi-SM integration has been set up
so that events can be forwarded to
Service Manager as incidents.

When a user creates a conversation for an
event in OMi, and then in Service Manager
opens the incident created from this event
and clicks the Open Conversation button, a
dialog displays, asking if the user wants to
create a new conversation.

This is incorrect. The expected behavior is
that the existing conversation created by
OMi opens.
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Problem

Workaround

QCCR1E80227

An EC down message is received if an LWSSO cookie refresh occurs between the time a
request is sent and the response is received.

To work around this issue, set
expirationPeriod to a large value in EC and
the SM Web tier LW-SSO configuration file
as shown in the following example:
<creation>
<lwssoCreationRef useHTTPOnly="true"
secureHTTPCookie="false">
<lwssoValidationRef
refid="ID000001"/>
<expirationPeriod>5000</expirationPer
iod>
</lwssoCreationRef>
</creation>

Doing this will significantly reduce the
chance of encountering this issue.

Upgrade Utility
SCR

Problem

Workaround

QCCR1E61837

After running the Upgrade Utility, messages
in the upgrade.log file are timestamped with
the time zone of the logged-in user instead of
the server's time zone. Therefore,
timestamps in the upgrade.log file may be
inconsistent with equivalent messages in the
sm.log file.

No workaround available at this time.

QCCR1E65346

The Upgrade Utility cannot be run when
logged in with a non-English language on a
localized system. This version of the Upgrade
Utility does not provide a localized interface.

Select English as the language when
logging into the system for an upgrade.

QCCR1E65585

The application upgrade fails with the
following error message:
"The record being added contains a NULL
key."
This issue occurs when the Upgrade Utility
tries to update the dbdict for a table that has
unmapped fields.

No workaround available at this time.
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SCR

Problem

Workaround

QCCR1E65660

The Upgrade Utility may add field mappings
for SQL fields that are already mapped in
tailoring. After an upgrade, the following
error message may occur when trying to
operate a record in that table:
"Duplicate mapping. HP Service Manager
fields (fax) and (pa.otopr.name) are both
mapped to SQL field (FAX).
Filename =probsummary"

To work around this issue, follow this
example.
Assume that two fields are mapped to the
same field, as follows:
CUS_A map to SQL_A
OOB_A map to SQL_A
Steps to re-map to fix this issue:
1

Type dbdict, and then open the
"probsummary" table.

2

Edit field CUS_A and rename SQL
field from SQL_A to SQL_B, save and
exit.

3

Re-open the "probsummary" table, edit
field OOB_A, and clear SQL field
mapping by removing SQL Name, SQL
Type and SQL Table.

4

Save, click "SM Alert" when it occurs,
then SQL_A will be created.

5

Re-open the "probsummary" table, edit
field OOB_A, rename SQL field from
SQL_A to SQL_C, save and exit.

6

Re-open the "probsummary" table, edit
field CUS_A, rename SQL field from
SQL_B to SQL_A, save and exit.
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SCR

Problem

Workaround

QCCR1E65713

The Chinese language is not activated
correctly after an upgrade. For example,
menus are displayed in English, and some
formats cannot be found.

To activate English and Chinese
languages, do the following:
1

Go to System Definitions, and open
table "language."

2

Click View all records in the table.

3

Locate the record with Name='English'
and ID='OLDSM7en', and then clear
checkbox "Active for logins."

4

Locate the record with Name='Chinese
Simplified' and ID='OLDSM7zh-Hans',
and then clear checkbox "Active for
logins."

5

Locate the record with Name='English'
and ID='en', and then select checkbox
"Active for logins."

6

Locate the record with Name='Chinese
Simplified' and ID='zh-Hans', and then
select checkbox "Active for logins."

7

Log out and then log in again with the
Chinese language.
All menus should be displayed in
Chinese now, and all formats can be
opened correctly.

QCCR1E65742

For customers upgrading to SM 9.30, the
option menu items: Administration,
Export/Unload, or View Localized Record
Tags are not available from the Security
Area screen that is accessed via the menu
path System Administration > Security >
Area. You will not be able to add or edit
Security settings from the Administration
menu item. Security Area is new
functionality in SM 9.30, and security
settings are not used in any OOB
configuration.

No workaround available at this time.

QCCR1E60910

Reports generated by the Assessment Toolkit
do not include certain tables with invalid
"nulltable" fields. For example, the
requested.for field in the ocmcowork table is
not defined as "nulltable" in the "sql.tables"
field in the corresponding dbdict. This is not
a valid "nulltable" field even though the
"sql.table.alias" field is set to "n1."

Not available at this time.
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SCR

Problem

Workaround

QCCR1E60206

Database types with non-standard names
cause database connection to fail. This issue
occurs because the Assessment Toolkit
recognizes only standard database type
names, such as squlserverXXXXX,
oracleXXXXX, and DB2XXXXX.

Not available at this time.

QCCR1E59536

The Assessment Toolkit does not support
testing connections on port 12670 even
though port 12670 is also a default port in
addition to port 13080.

Not available at this time.

QCCR1E67351

ServiceCenter or Service Manager timeout
errors may occur.

For Service Manager 7 and later: Add the
heartbeatinterval parameter and set the
value to 6000 in the sm.ini configuration
file.
For ServiceCenter 6.2.8: Add the
sctimeramount parameter and set the
value to 6000 in the sc.ini configuration
file.

QCCR1E65618

When exporting reports to RTF files, the HP
logo is truncated.

Not available at this time.

QCCR1E67432

When re-running reports using the Run Last
feature, some of the reports may include only
the last page.

Every time you generate reports, the
reports are temporarily saved in a folder
named after the corresponding timestamp.
You can manually copy the specific reports
into the latest folder from an earlier folder,
and then view or export the reports.

QCCR1E68559

Some application data becomes corrupted
after you upgrade the server run-time
environment to Service Manager 9.30. Some
records that still exist in the RDBMS cannot
be displayed in Service Manager
applications. The following error message is
displayed on the client interface and logged
in the sm.log file:

To fix this issue:
1

Open the dbdict for the record type
that cannot be displayed.

2

Increase the lengths of the fields that
may be too small to hold the required
data. Fields that require an increase in
length have all the following
characteristics:
¾ Contains multi-byte characters.
¾ Has a data type of char, nchar, or
vchar.
¾ Is used for a value that is likely to
reach the field length limit, for
example, a description field.

3

Log off the Service Manager Client and
log back on.

SQL code=1046 message=ORA-01406:
fetched column value was truncated
This problem occurs if the Service
Manager server is working on an Oracle
database that does not use the AL32UTF8
character set.
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SCR

Problem

Workaround

QCCR1E68779

Some application data becomes corrupted
after you upgrade the server run-time
environment to Service Manager 9.30. Some
records that still exist in the RDBMS cannot
be displayed in Service Manager
applications. An error message that
resembles the following is displayed on the
client interface and logged in the sm.log file:

To fix this issue:

ORA-02374: conversion error loading
table "SC_OWNER"."PROBLEMM1"
ORA-12899: value too large for column
BRIEF_DESCRIPTION (actual: 257,
maximum: 255)
ORA-02372: data for row:
BRIEF_DESCRIPTION : 'An e-mail
addressed to you from'

1

Open the dbdict for the record type
that cannot be displayed.

2

Increase the lengths of the fields that
may be too small to hold the required
data as indicated in the error message.

3

Log off the Service Manager Client and
log back on.

This problem occurs if the Service Manager
server is working on an Oracle database that
does not use the AL32UTF8 character set.

QCCR1E68320

The upgrade process fails and error messages
that resemble the following are displayed on
the client interface and logged in the sm.log
file:
" 2860( 532) 09/05/2011 01:45:39 RTE I
dbInsert: The record being added
contains a duplicate key
2860( 532) 09/05/2011 01:45:39 RTE I
dbInsert: file:(notification)
key:(id=PRE7.11.000ChM Change Open_1)
2860( 532) 09/05/2011 01:45:39 RTE E
Error: SQL code=1 message=ORA=00001:
unique constraint(SM.NOTIFICATIONM1_P)
violated
2860( 532) 09/05/2011 01:45:39 RTE I
dbInsert: The record being added
contains a duplicate key
2860( 532) 09/05/2011 01:45:39 RTE I
dbInsert: file:(svcCatInterface)
key:(interface.name=Open an Incident)"

To fix this issue, follow these steps before
starting the upgrade:
1

Open the dbdict for the svcCatInterface
table, and remove the
service_request_id unique key.

2

Log in to the RDBMS, and removed the
mapped index for the
service_request_idunique key.
Example: For an Oracle RDBMS, run
this SQL statement: rdbms drop index
SVCCATINTERFACEM1_2.

3

In the RDBMS, remove the mapped
constraint and index for the
notification table. Example: For an
Oracle RDBMS, run these SQL
statements: alter table notificationm1
drop constraint NOTIFICATIONM1_P
drop index NOTIFICATIONM1_P

Service Request Catalog Limitations and Known Issues
The following is a cumulative list of known issues and limitations in SRC 1.4, including those that already
exist in SRC1.3.
SCR

Problem

Workaround

The buttons on all pop-up dialogue
boxes do not support keyboard
access.

No workaround available at this time.

SRC 1.40
QCCR1M1985
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Problem

Workaround

QCCR1M4436

When user A requests items on
behalf of user B in ROB (request-onbehalf) mode, user A can only select
the items that user B can see, which
is right.
The problem is when user A
resubmits an interaction submitted
on behalf of user B in ROB mode,
user A can add items that user A
can see, instead of the ones that
user B can see. This behavior is not
consistent with ROB mode.

No workaround available at this time.

QCCR1M5104

If the name of one custom doc type
(for example, myDocType) is a substring of another doc type name (for
example, myDocType2), the Doc
Type filter on the KM search result
page does not work precisely. For
example, myDocType2 documents
appear in the myDocType search
results.

Do not use doc type names that are a substring of
another doc type name.

QCCR1M5040

Catalog trees are missing in
Mandanten mode. A catalog tree
does not display in SRC, if the
categories/items on the tree belong
to more than one company.
For example, if the catalog
administrator defines a category
item for Company B and its parent
category for Company A, users of
Company A and Company B can
search out the category item, but
none of them will see a catalog tree.

To solve this issue:

QCCR1M2786

When users log in to SRC with a
non-English language, the
Subscription facet options
(Requested, Active, Cancellation,
Canceled, and Denied) display in
English.

•

In multi-company mode, do not specify more
than one company for the entire catalog tree.

•

For existing data, separate the whole catalog
tree into separate companies.

Define a multi-language label for the subscription
status in the SM global list.
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Problem

Workaround

QCCR1M5235

With Process Designer Content Pack
9.30.1 applied in Service Manager,
after logging in to SRC, an operator
who has required change security
role (for example, a system
administrator) cannot select the
Change Management module for
Approval Delegation (on the
Approval Delegation page, the
Change Management module is not
available from the Choose Type
dropdown list ).

Perform the following steps to resolve this problem:
1 Log in to the Service Manager Windows
client.
2 Open the specific operator record.
3 From the menu bar, click Window > Show
View > Other… > RAD Debugger, and then
click OK to open the RAD Debugger.
4 In the RAD Debugger command line, execute
command d profile.change in $L.file
to get the Change profile of this operator. If
the operator record was created before the PD
Content Pack was applied, a non-NULL value
should be returned; otherwise a NULL value
is returned.
5 If the command returns a NULL value,
execute x profile.change in
$L.file={"DEFAULT"}, and then save the
operator record. This assigns the operator the
DEFAULT change profile.
6 Navigate to Tailoring > Database Manager,
open table “cm3profile”, and then search for
the Change profile returned in step 4 or step
5. On the profile’s Approvals/Groups tab,
select the Can Delegate Approvals option.
7 Save the profile and log out.

QCCR1M4457

SRC does not support Arabic rightto-left display.

No workaround available at this time.

When users log in with the Arabic
locale (for example, select [ar] from
Internet Explorer's Language
Preference), SRC cannot display
Arabic text, the UI layout and user
input text in a right-to-left mode.
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Problem

Workaround

QCCR1M5356

A user cannot log in to SRC in an
LDAP environment until after
logging in to the SM Windows or
Web client as the same user.

To solve this issue:
1

In the Service Manager sm.ini file, make sure
that ldapauthenticateonly is disabled (not
present or commented out).

2

In the sm.ini file, enter ldapdisable:1.

3

Restart the SM server.

4

Log in to Service Manager as a system
administrator.

5

Based on an existing operator record, create a
template that you want to use to create operator
records for first-time users.
a

Open an existing record that you want to
use as a template.

b

Replace the Login Name with
*SYSDEFAULTS.

c

Edit any other fields that you want and
delete all fields that you plan to map to
LDAP.

d

Make sure the "SOAP API" capability word
is added for this operator.

e

On the Security tab, select the Template
Operator checkbox.

f

Click the Add button to add your template
to the operator file.

4

Click OK and Back to return to the
menu.gui.home form.

5

Click System Administration > Ongoing
Maintenance > System > LDAP Mapping.

6

Configure necessary fields for the operator and
contacts files in LDAP mapping.

7

Make sure LDAP is set to be the Primary Data
Source.

8

Be sure that the SM Unique Key Contained
in the LDAP DN field is unchecked (not
NULL).

9

Click Save button and then OK.

10 In the server sm.ini file, change the ldapdisable
value from 1 to 0: (ldapdisable:0).
11 Restart the SM server.
SRC 1.3
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Problem

Workaround

QCCR1M1900

In the SRC UI, the detailed
description of a catalog item is not
showing correctly and getting
truncated in some cases. A SOAP
API call to the catalog item returns
the data correctly, but SRC UI is
unable to display that data
correctly.

No workaround available at this time.

QCCR1E77087

When searching employees and one
of the employees in the returned
search list has a contacts record
with no value for the operator.id, the
following error message is received:
"An Error occurred"

Make sure to set a value for the operator.id field in
all contacts records.

QCCR1E78460

The display list for Urgency displays
incorrectly in SRC when creating
request.

No workaround available at this time.

QCCR1E79281

When you open an Incident of the
Request for Change type in the SM
Web Client or Windows Client, the
category is displayed as a Request
for Change. However, if you now go
into SRC and look at the same
interaction, the category is
displayed as "Incident."

No workaround available at this time.

QCCR1E79588

The popup window for contact
lookup in SRC is not resized
correctly when the contact name is
long in length. As a result, some
contact names are not displayed
successfully.

No workaround available at this time.

QCCR1E79594

The statuses of the individual items
in a bundle are not displayed. If the
items that make up the bundle are
ordered as individual items and
then submitted as one SD, the item
status values can be displayed
correctly.

No workaround available at this time.
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Problem

Workaround

QCCR1E77950

If you fill
"999999999999999999999999" as
the value in a number-field in a
Service Request, the value is
replaced by "2147483647." If the
order process is continued, the
following error is received one-click
before the SD is created:

No workaround available at this time.

"NewServer - Validation failed

Additional Harddisk Size in GB
(1) is mandatory Additional
Harddisk Size in GB (1) is
mandatory"

QCCR1E80249

Date formats display in the US date
format (where the server is located)
despite users logging the request
from another country (so the
regional settings on the PC differ).
This behavior occurs even though
these users’ Operator and Contact
records also have Australian time
zones and date formats applied.

No workaround available at this time.

QCCR1E79169

When adding a comment to a
request in SRC in a locale other
than English, the comment is not
posted and a (localized) error is
received.

No workaround available at this time.
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Back-out Instructions
If you want to restore your Service Manager system to its original state after installing Service Manager
9.31, follow these guidelines.

Server
Before applying the server patch, make a backup of the server installation folder. For example, C:\Program
Files\HP\Service Manager 9.30\Server.
To roll back your server to its original state, remove the existing server installation folder and copy the old
one back.

Applications
When loading an unload file
Before loading an unload file, perform the following steps to make a backup of the files to be modified by the
unload file:
1

Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to
the unload file.

2

Click List Contents on the menu bar, to view a list of files that have been updated in this unload.

3

Go to Tailoring > RAD Editor, search for the files you got in step 2, and click More > Export/Unload.

4

In the popup window, specify your backup upload file path/name, and click Unload Appl. Note: Make
sure that Append to file is selected.

When applying an application patch
Before applying an application patch, make a backup of your database. To roll back your application
changes, restore your database to the backup.

Web Tier
Before deploying the new web tier, back up your web.xml file, application-context.xml, splash screen,
style sheets, and any other customizations you made, including your webtier-9.30.war (webtier-ear9.30.ear) file.
To roll back to the old web tier:
1

Delete or uninstall the existing web tier.

2

Redeploy the old web tier.

3

Restore your old customizations.
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Windows Client
You can only uninstall the new Windows client, and then reinstall the old version.

Installation Notes
Note: Service Manager (SM) 9.31 includes all the features of SM 9.30.p5, SM9.30ap3, SM9.30up6, and
previous releases. If you are upgrading from a version earlier than SM 9.30.p5, 9.30ap3, or 9.30up6, review
the release notes for the following releases since SM9.30:
•

SM9.30p1 through p5

•

SM9.30ap1 through ap3

•

SM9.30up1 through up6

Digital signature notice
HP signs Windows executable files with a digital signature. Since SM 9.30.p3, this process has been updated
to use a new VeriSign root certificate. On a Windows system that does not have the new VeriSign root or
intermediate certificate installed, when the user right-clicks the file and then goes to Properties > Digital
Signatures > Details, a verification error will display: “The certificate in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as
documented at: https://knowledge.verisign.com/support/ssl-certificatessupport/index?page=content&actp=CROSSLINK&id=SO19140
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Applications Update Installation
Before applying the 9.31 applications, pay attention to the following.

Content Patch Dependencies
There are a number of Service Manager 9.30 content packs (CPs) that were released before this release. In
general, you should install these content packs and the 9.31 applications in their release order to minimize
conflicts. For instance, if you install the 9.31 applications before Process Designer Content Pack 2 (PD CP2),
conflicts (renamed records) will occur.
•

The application patch is compatible with the following HP Standard content packs that have been
released for Service Manager 9.30:

•

HTML Email Solution

•

UCMDB Integration Enhancement Content Pack 9.30.0 (This Content Pack has been merged into the
out-of-the-box 9.31 Application Patch)

•

Process Designer Content Pack 9.30.1

There are some conflicts between Process Designer Content Pack 9.30.1 and the 9.31 Applications Patch. For
information on how to resolve these conflicts, as well as recommended content pack installation sequences,
see Process Designer Content Pack 9.30.1 Limitations.

Prerequisites
•

Service Manager application release level: 9.30 or 9.30 Applications Patch 1, 2, or 3

•

Service Manager application release language: All languages for 9.30

•

Service Manager client/server release level: 9.31 or higher

•

The Service Manager server process must have read-write access to the database

Upgrading to the 9.31 Applications
Existing customers and new customers can upgrade to the 9.31 applications using different approaches. For
detailed instructions, see the Applications Patch Manager Guide and Upgrade Guides for Service Manager
9.31.
For a list of changed objects, see the Service Manager 9.31 Applications Patch Manager Guide
(SM9.31_ApplicationPatchObjectChangedList.pdf).
For existing customers:
•

To upgrade from the SM9.30 applications or 9.30 Applications Patch 1, 2, or 3, use the SM9.31
Applications Patch Manager.

•

To upgrade from the 7.11 or 9.21 applications, use the SM9.31 Upgrade Utility.

For new customers:
Install SM9.30 GA first, and then upgrade to the SM9.31 applications using the SM9.31 Applications Patch
Manager.
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Notes for Service Request Catalog Customers
If you are upgrading from an applications version earlier than 9.30 using the Upgrade Utility, the following
requirements must be met for SRC to work properly:
•

The type of the "id.attach" field in the "svcCatalog" table must be "number".

•

The Unique Key of the "Approval" table must be {"unique.key", "file.name", "name", "component"}.

•

The Unique Key of the "ApprovalLog" table must be {"counter", "file.name", "unique.key", "component"}.

For detailed instructions, see the "Handle key change failure" and "Data type mismatches" sections in the
upgrade guide.

Web Tier Installation
The Web Tier update consists of a compressed file, sm9.31.0022_Web_Tier.zip. The specific upgrade
process depends on your particular Web application server, but follows the same steps as deploying a new
installation.
The Service Manager Web Tier contains a J2EE-compliant web application that runs on your web
application server. Each web application server has its own method of deploying web applications. See your
web application server documentation for specific instructions on deploying a web application.
The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must
save your customized files and replace the new version of these files with your customized version. For more
information, refer to the Service Manager Interactive Installation Guide.
Note on Tomcat 7.0: If you plan to deploy the web tier on Tomcat 7.0 using the Tomcat Manager, be sure to
set the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat
7.0_Home>webapps\manager\WEB-INF\web.xml to an appropriate value greater than the web tier .war
file size; otherwise the deployment request will be rejected because the web tier .war file exceeds the default
maximum values. This restriction does not exist in Tomcat 6.0.
1

Back up your web.xml file, application-context.xml file, splash screen, style sheets, and any other
customizations you made, including your webtier-x.xx.war (webtier-ear-x.xx.ear) file.

2

Delete or uninstall the existing .war or .ear file.

3

Deploy the new webtier-9.31.war (.ear) file by following the instructions in the Service Manager
9.30 Interactive Installation Guide.
Note: HP recommends that you deploy with a unique context root, for example /webtier-9.31.0022.

4

Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to ensure
that any new parameters are properly merged into the files used in your final deployment. Do this for
application-context.xml as well as any other files you may have customized (such as style sheets
and splash screens).

5

Make any new customizations necessary for your deployment.

6

Restart the Application server.
Note: Before accessing the new Web Tier, HP recommends that all users empty their browser cache.
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Windows Client Installation
The Windows client update consists of a compressed file, sm9.31.0022_Windows_Client.zip, which
contains the executable installation files.
To install the Windows client update:
1

Stop the Service Manager Windows client.

2

Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.)

3

Run setup.exe and install the client by following the instructions in the Service Manager 9.30
Interactive Installation guide.

4

Check the version in Help > About Service Manager Client.
The client should be Release: 9.31.0022.

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.31.0022_<OS>.zip
(or .tar), which contains the Service Manager server files. These files add to or replace the files in the
[SM Server Root]\ ([SM Server Root]/) RUN, irlang, legacyintegration, and
platform_unloads directories.

Upgrade Paths
This server patch must be applied on top of one of the following versions/patch levels of the SM server:
•

SM9.30 GA

•

SM9.30 Patch/Hotfix

The following server upgrade paths are recommended:
•

New customers: Install the SM9.30 GA server, and then directly apply this server patch;

•

Existing SC6.2, SM7.11 and 9.21 customers: Uninstall the old server, install the SM9.30 GA server, and
then apply this server patch;

•

Existing SM9.30 customers: Apply this server patch.

For installation instructions of the SM9.30 GA server, see the Service Manager 9.30 Interactive Installation
Guide, which is available from the HP Software Manuals Site:
http://h20230.www2.hp.com/selfsolve/manuals
For installation instructions of the server patch, see the following.

Server Patch Installation Steps
Note: If you have a horizontally scaled system, you must upgrade all server instances.
Important: This server update will upgrade the embedded Tomcat to version 6.0.35. It will also update the
schemastub.xml file (\RUN\km\styles\schemastub.xml), which contains changes required for the KM Solr
search engine (see Knowledge Management Update Installation). In addition, your server’s lwssofmconf.xml
file will also be updated.
To install the Server update:
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1

Stop all Service Manager clients.

2

Stop the Service Manager server.

3

Make a backup of the RUN directory.

4

Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.35 when you
extract the server files later.

5

Delete the RUN/lib directory.

6

Extract the compressed files for your operating system into the main Service Manager directory on the
server. The default path is: C:\Program Files\HP\Service Manager 9.30\Server.

7

For UNIX servers, set the file permissions for all Service Manager files to 755.

8

If you have made any customizations/changes to the original RUN/tomcat folder, restore them in the
new RUN/tomcat folder.

9

Your server’s old lwssofmconf.xml file has been overwritten. If you have configured LW-SSO in the old
file, merge the parameter settings in the old file from your backup of the RUN directory into the new
lwssofmconf.xml file.

10 Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a new version. If you want to use the new KM Solr search engine features, follow the steps
described in the Solr Search Engine Update Installation section; otherwise, copy your old
schemastub.xml file back.
11 Make sure the server is stopped, and run the "sm -unlockdatabase" command.
The purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.
Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required whenever you
change the server’s IP address after your upgrade to 9.30p4 or later.
12 Restart the Service Manager server.
13 Restart the Service Manager clients.
14 Check the version in Help > About Service Manager Server.
The server should be Release: 9.31.0022.

Application Unload Installation
Important: Unlike in Service Manager 9.30 patch 5 or earlier, all unload files in the server’s
platform_unloads directory in this release have been already merged into the Service Manager 9.31
applications. These files are provided just in case you do not plan to upgrade to applications 9.31 while still
want to take advantage of the relevant new features/fixes.
When you extract sm9.31.0022_<OS>.zip (or .tar), the unload files included in this release are added to
your [SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads) directory.
An unload file is provided when a platform fix (in most cases, a server fix) in a platform patch also requires
an applications change to resolve an issue. Unload files introduced in earlier patches are also included in
each cumulative patch release. If you have not already applied them for a previous patch, you should also
apply those that are intended for your applications version. For more details about these applications
updates, see the Release Notes for those patches.
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Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 should be
applied first, then those introduced in patch 2, and so on. However, unload files introduced in the same
patch normally can be installed in a random order (there might be occasional exceptions).

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:
•

<CR_ID>: The identification number of the applications defect that the unload file fixes. For example,
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any).

•

SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example,
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2
and should be used for patch 2 or later.
Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This
example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or later.

•

SMxxx: The Service Manager applications version that requires the unload file. For example, SM711,
which means the unload file is intended only for Service Manager applications version 7.11.
Note: If the applications version suffix is omitted, the unload file is then intended for all applications
versions compatible with the server version, unless otherwise specified. For example,
QCCR1Exxxx_SM930P4.unl is intended for applications versions 7.11, 9.20, and 9.30 (which are
compatible with Service Manager server 9.30), unless otherwise specified in the unload file description.
For information on the applicable applications versions for each unload file included in the current
patch, see Unload Files Included in the Current Patch.

Unload Files Included in the Current Patch
The following are unload files included in the current patch release.
Unload file

Introduced
in

Used for
apps
version(s)

Description

QCCR1E78589_SM931_PD2.unl

9.31

9.30

Fixes the conflicts that occur after
installing Service Manager 9.30 PD CP2
and then upgrading to the Service
Manager 9.31 applications.
Installation sequence:
1. PD CP2
2. 9.31 applications
3. This unload

Note: This unload file is not needed if
you do not have PD CP2 installed.

QCCR1E76227_SM930P6_SM930.
unl

9.31

9.31

Contains the code changes to support
localization of incident/change priority
and urgency strings for the Mobility
Client.

QCCR1E78794_SM930P6_SM930.
unl

9.31

9.30

Removes incident.assignee when a Web
Service call specifies the assignee as
'NULL' via the Mobility Client. See
QCCR1E78794.
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Unload file

Introduced
in

Used for
apps
version(s)

Description

QCCR1E76796_SM930P6_SM930.
unl

9.31

9.30

Provides the ability to turn on debugging
dynamically for user sessions or
schedulers.
Note: This unload requires the SM9.31
server.

QCCR1E71099_SM930P5_SM930.
unl

9.30p5

9.30

Displays Value Lists instead of the data
directly retrieved from the database in a
QBE list when adding a field by using
Modify Columns.
Associated server fix: QCCR1E71099
(see the 9.30p5 Release Notes)

QCCR1E71139_SM930P5_SM930.
unl

9.30p5

9.30

Works with server fix QCCR1E71139 to
solve this issue: When Service Manager
is configured to use LDAP as the
authentication data source, the user is
still forced to change the password if the
user is expired in the local database.

QCCR1E31941_SM930P4_SM930.
unl

9.30P4

9.30

Enables users to use a pre-configured
decimal symbol when completing
numeric fields. See QCCR1E31941.
Notes:
This enhancement requires a 9.30p4 or
later server; however if you are using
RTE version 9.30 with applications
version 7.11 or 9.20, do not load this
unload file; you can safely upgrade your
server to 9.30p4 or later without
applying this applications change.

Associated server fix: QCCR1E31941.
QCCR1E73452_SM930P4.unl

9.30P4

7.11 - 9.30

Enables Mandanten restricting queries
to be updated correctly after a profile is
edited.
Associated server fix: QCCR1E71897.

QCCR1E67072_SM930P4.unl

9.30P3

7.11 and
9.20

Enables users to take advantage of the
new KMStatusListener background
process.

Note: This unload file is not needed for
applications version 9.30 or later, which
supports only the Solr Search Engine.
Associated server fix: QCCR1E67071.
QCCR1E70163_SM930P4_SM711.
unl

9.30P3

7.11

Fixes the issue that the KMUpdate
process terminates abnormally.
Associated server fix: QCCR1E69687.
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Unload file

Introduced
in

Used for
apps
version(s)

Description

QCCR1E70163_SM930P4_SM920.
unl

9.30P3

9.20

Fixes the issue that the KMUpdate
process terminates abnormally.
Associated server fix: QCCR1E69687.

QCCR1E70163_SM930P4_SM930.
unl

9.30P3

9.30

Fixes the issue that the KMUpdate
process terminates abnormally.
Associated server fix: QCCR1E69687.

QCCR1E67647_SM930P3.unl

9.30P3

7.11 - 9.30

Updates the exception message that
occurs in the request response when
closing an interaction by calling
CloseInteraction from a web service
without specifying the localSolution field
in the request.
Associated server fix: QCCR1E54192.

QCCR1E67610_SM930P2.unl

9.30P2

7.11 - 9.30

Enables you to block potentially
dangerous attachments.
Associated server fix: QCCR1E64290.

To load an unload file:
1

Select either client or server-side unload, depending on the location of the unload files.
a

From the Windows client, go to Window > Preferences > HP Service Manager.

b

Flag Client-Side Load/Unload if the files are on the client machine, and clear the flag if they are
on the server.

c

Restart the Windows client if you changed the setting.

2

Open Tailoring > Database Manager.

3

Right-click the form or open the options menu and select Import/Load.

4

Fill in the following fields.

Field

Description

File Name

Type the name and path of the file to load.

Import Descriptor

Since unload files do not require an Import Descriptor record, leave this field
blank.

File Type

Select the source operating system of the unload file.

Messages Option —
All Messages

Select this option to see all messages that Service Manager generates loading the
file.

Messages Option —
Totals Only

Select this option to see only the total number of files Service Manager loads.

Messages Option —
None

Select this option to hide all messages that Service Manager generates when
loading the file.

Note: You can view the contents of an unload file before importing it by clicking List Contents.
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5

Click Load FG.

Knowledge Management Update Installation
Important: All unload files in the Knowledge Management package in this release are already part of the
Service Manager 9.31 applications. These unloads are provided in case you do not plan to upgrade your
applications to version 9.31. If you plan to upgrade to applications version 9.31, you do not need to load these
unload files.
The Knowledge Management package (sm9.31.0022_KM.zip) updates the KM Solr Search Engine and the
KM Import Utility:
KM Solr Search Engine:
Note: The KM Solr Search Engine is supported only for the SM9.30 or later applications. If you are using
the SM7.11 or 9.21 applications, ignore this Solr Search Engine update.
•

The kmsolr_unloads folder, which contains unload files that will update your KM Solr search engine:
— QCCR1E67750_SM930P5_SM930.unl
— QCCR1E77409_SM930P5_SM930.unl
— QCCR1E75104_SM9.30P5_SM930.unl

•

The knowledgemanagement folder: This folder contains updated files for the KM Solr search engine:
— knowledgemanagement\kmsearchengine\KMCores\kmcore\conf\schema.xml
— knowledgemanagement\kmsearchengine\KMCores\kmcore\conf\solrconfig.xml
— knowledgemanagement\kmsearchengine\languages\data\jp.uhtagger
— knowledgemanagement\kmsearchengine\lib\tg_solr.jar
Note: These files should overwrite the old files in your search engine’s kmsearchengine folder (for
example, C:\Program Files (x86)\HP\Service Manager 9.30\Search_Engine\kmsearchengine).

KM Import Utility:
•

km-import-9.31.zip: This file is an updated version of the KM Import utility.

KM Solr Search Engine Update Installation
Note: The KM Solr Search Engine is supported only for SM9.30 or later applications. Ignore this section if
you are on the SM7.11 or 9.21 applications.
The Solr Search Engine update aims to enable the following features or fix for Knowledge Management
searches:
•

Support of Knowledge Management search for Service Request Catalog (SRC) 1.4

•

Ability to specify search result sort preferences in Knowledge Management (by Modified Date, Status, or
Relevancy). For more information, see the SM9.30p4 Release Notes.

•

Ability to select whether or not to highlight attachment content in KM search results. A new option
(Highlight content of attachment in search result?) is available in the KM environment record. By
default, this option is not selected, and therefore attachment content in user’s KM search results will not
be highlighted. This can significantly improve search performance when there are a large number of
large-size attachments like PDF manuals in the knowledgebases. For more information, see the
“Highlighting Attachment Content in Search Results Optional” section in the 9.30p5 Release Notes.
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•

Fix QCCR75104 (Searches that use "NOT" or '-' to exclude terms produce unexpected results. For
example, the search results when using the 'None of these words' option in Advanced Search may include
the search terms that should have been excluded.) For more information, see the 9.30p5 Release Notes.

To install the Solr Search Engine update:
1

Make sure you have already installed the 9.31 server package.
Note: The server package will update your schemastub.xml file to support the new features. If you do
not want to use the new features, copy your old schemastub.xml file back from the backup of your
server’s RUN directory so that your Search Engine can continue to work.

2

Make a backup of your Search Engine installation folder.

3

Update your Search Engine’s kmsearchengine folder (for example: C:\Program Files (x86)\HP\Service
Manager 9.30\Search_Engine\kmsearchengine) with the new files under the
kmowledgemanagement\kmsearchengine folder from the 9.31 KM package.

4

If you want to enable the “Search Result Sort Preferences” feature, follow the instructions in the 9.30p4
Release Notes.
Note: If you have already upgraded to applications 9.31 or have already enabled this feature for 9.30p4
or 9.30p5, ignore this step.
Warning: QCCR1E67750_SM930P5_SM930.unl must be loaded before the other two KM unload files,
otherwise conflicts will occur.

5

If you want to enable the “Highlighting Attachment Content in Search Results Optional” feature, follow
the instructions in the 9.30p5 Release Notes.
Note: If you have already upgraded to applications 9.31 or have already enabled this feature for 9.30p5,
ignore this step, because the Highlight content of attachment in search result? option should be
already available in your KM Environment record (Knowledge Management > Administration >
Environment).

6

Load QCCR1E75104_SM9.30P5_SM930.unl to take advantage of the fix QCCR1E75104 to the “Filter
by…” functionality for Advanced Search.

7

Log off Service Manager and log back in for your changes to take effect.

8

Perform a full re-indexing for all of your knowledgebases.

9

Verify that the Search Result Sort Preferences feature is working correctly, by doing a knowledgebase
search and then changing your sort preference. For details, see the 9.30p4 Release Notes.

10 Verify that the “Highlighting Attachment Content in Search Results Optional” feature is working
properly.
a

Open the KM Environment record. The Highlight content of attachment in search result?
option is not selected by default.

b

If you want the keywords in both document bodies and attachments are highlighted in search
results, select the Highlight content of attachment in search result? option; otherwise leave it
unselected to highlight only keywords in document bodies.
Note: Selecting this option could increase the search response time when there are large
attachments like PDF manuals.

c

Perform a knowledgebase search, to verify that in your search results the keywords in attachments
are highlighted or not highlighted according to your setting.

11 Verify the “Filter by…” functionality fix by doing an advanced knowledgebase search.
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Knowledge Management Import Utility Installation
Note: The km-import-9.31.zip file included in this release in same with the Import Utility .zip file in the
SM9.30p4 and SM9.30p5 releases.
Extract km-import-9.31.zip in the Knowledge Management package to a local drive. For detailed
instructions on the use of the import utility, see the README file packaged in this .zip file.

Mobile Applications Update Installation
The Mobile Applications package (sm9.31.0022_Mobility.zip) contains an updated version of the
mobileItsmWebApp.war file.
To install the Mobile Applications update:
1

Install Service Manager Mobile Applications version 1.0 shipped with the Service Manager 9.30 DVD, if
you have not already done so. For detailed instructions, see the HP Service Manager 9.31 Mobile
Applications User Guide.

2

Make sure that the Apache Tomcat SMmobility Windows service or the Mobile Applications Tomcat
server is stopped.

3

If you have already configured Mobile Applications version 1.0 on your system before installing this
patch, make a backup of the following folder by renaming it:
<SM_Mobility>\Tomcat\webapps\mobileItsmWebApp
For example, rename it to mobileItsmWebApp_old.

4

Copy the mobileItsmWebApp.war file packaged in the sm9.31.0022_Mobility.zip file to the following
folder to overwrite the old file: <SM_Mobility>\Tomcat\webapps\

5

If you have already configured Mobile Applications before installing this patch, do the following:
a

Restore your customizations by copying your old AppConfig.groovy and CustomConfig.groovy files
back to overwrite the configuration files in the new mobileItsmWebApp.war file.

b

At the end of the CustomConfig.groovy file, add itsm.PageMaxRecords=10. You can change the
parameter value from the default (10) to better suit your needs.
Note: This is a new parameter introduced in version 9.31 (default: 10). It defines the maximum
number of records that can be displayed on each page of the following types of lists:
— Home page: the Incident (Awaiting My Approval, and Assigned to My Groups), and Change
(Awaiting My Approval, and Assigned to My Groups) lists
— Incident Detail page: Status, Activities, Assignee, and Group lists
— Change Detail page: Activities, Group, Approvals, and Tasks lists
Warning: The itsm.PageMaxRecords parameter is mandatory. If it is not specified in the
CustomConfig.groovy file, the Mobility Client will not work.

c

6

If needed, in the restored CustomConfig.groovy file, continue to configure language and dateFormat
settings (supported only in this Mobility patch). For details, see the SM9.31 Mobile Applications user
guide.

If you have not yet configured Mobile Applications before installing this patch, configure the Mobile
Applications by following the instructions in the SM9.31 Mobile Applications user guide. In this case,
you use the new CustomConfig.groovy file, which already contains the itsm.PageMaxRecords
parameter.
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7

In <SM_Mobility>\Tomcat\conf\server.xml, add the URIEncoding="UTF-8" attribute for the HTTP
connector as shown below:
<Connector port="8080" protocol="HTTP/1.1"
connectionTimeout="120000"
redirectPort="8443" URIEncoding="UTF-8" />

8

Start the Apache Tomcat SMmobility Windows service or start the Mobile Applications Tomcat server.
The following new folder is created: <SM_Mobility>\Tomcat\webapps\mobileItsmWebApp

ODBC Driver Update Installation
Note: The ODBC .zip file is same with the one shipped with the SM9.30p4 and SM930p5 releases.
The ODBC Driver update consists of the sm9.31.0022_ODBC.zip file, which contains the following updated
files:
•

Scodbc32.dll

•

sci18n.dll

•

sccl32.dll

To install the ODBC Driver update:
1

Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine
Systems\ServiceCenter 6.2\ODBC Driver.

2

When prompted, replace the three old DLL files with the new ones.

Service Request Catalog (SRC) 1.4 Installation
Extract the serviceRequestCatalog_SRC1.40.zip file, and install SRC 1.4.
For detailed instructions, see the Service Request Catalog 1.4 Interactive Installation Guide.

Verified Environments
The Support Matrix lists supported versions of operating systems, browsers, HP Software products, and
other compatibility and support information.
To access the Support Matrix:
1

Use a browser to navigate to the Software Support Online (SSO) web page:
http://support.openview.hp.com/sc/support_matrices.jsp

2

Log on with your Customer ID and password or your HP Passport sign-in.

3

Navigate to the applicable information.
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Local Language Support
UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and
language. Service Manager 9.31 supports UTF-8 as an encoding method for new or existing data. It can
support multiple languages that adhere to the Unicode standard on the same server.

Mobility Localization Support
Service Manager 9.31 Mobile Applications support the following languages: English, French, German,
Japanese, and Spanish.

Service Request Catalog 1.4 Localization Support
Service Request Catalog 1.4 supports the following languages: Arabic, Brazilian Portuguese, Czech, Dutch,
English, French, German, Hungarian, Italian, Japanese, Korean, Polish, Russian, Simplified Chinese, and
Spanish.

Appendix. Server Created New Tables
The following table lists the new tables (files) the server patch creates in your database.
Note: If you need to roll back after applying the server patch, you can either keep the new tables or
delete them from your database.
Table

Description

Introduced in Version

lock

Introduced for the new locking mechanism to store exclusive locks.

9.31

lockshared

Introduced for the new locking mechanism to store shared locks.

9.31

Support
You can visit the HP Software support web site at:
www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP
Software offers.
HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient
way to access interactive technical support tools needed to manage your business. As a valued support
customer, you can benefit by using the support site to:
•

Search for knowledge documents of interest

•

Submit and track support cases and enhancement requests

•

Download software patches
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•

Manage support contracts

•

Look up HP support contacts

•

Review information about available services

•

Enter into discussions with other software customers

•

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require
an active support contract. To find more information about support access levels, go to the following URL:
http://h20230.www2.hp.com/new_access_levels.jsp
To register for an HP Passport ID, go to the following URL:
http://h20229.www2.hp.com/passport-registration.html
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Legal Notices
© Copyright 1994-2012 Hewlett-Packard Development Company, L.P.
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard
commercial license.
The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an additional
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
The information contained herein is subject to change without notice.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright © Jive Software,
1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino software Copyright © 1998-2004
The Mozilla Organization. This product includes software developed by the OpenSSL Project for use in the
OpenSSL toolkit. (http:// www.openssl.org). OpenSSL software copyright 1998-2005 The OpenSSL Project.
All rights reserved. This project includes software developed by the MX4J project
(http://mx4j.sourceforge.net). MX4J software copyright © 2001-2004 MX4J Team. All rights reserved.
JFreeChart software © 2000-2004, Object Refinery Limited. All rights reserved. JDOM software copyright ©
2000 Brett McLaughlin, Jason Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory
SDK Copyright © 1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis
Technology Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 Thomas
Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object Technology, Inc. and is
protected by US and international copyright law. Crystal Reports Pro and Crystal RTE software © 2001
Crystal Decisions, Inc., All rights reserved. Eclipse software © Copyright 2000, 2004 IBM Corporation and
others. All rights reserved. Copyright 2001-2004 Kiran Kaja and Robert A. van Engelen, Genivia Inc. All
rights reserved. Xtree copyright 2004 Emil A. Eklund. This product includes software developed by the
Indiana University Extreme! Lab (<http:// www.extreme.indiana.edu/>). Portions copyright © Daniel G.
Hyans, 1998. cbg.editor Eclipse plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in
this product is gSOAP software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van
Engelen, Genivia Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved.
Distributed under the Terms of Use in http:// www.unicode.org/ copyright.html.
Java is a registered trademark of Oracle and/or its affiliates.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.
UNIX® is a registered trademark of The Open Group.
For a complete list of open source and third party acknowledgements, visit the HP Software Support Online
web site and search for the product manual called HP Service Manager Open Source and Third Party
License Agreements.
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